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1 Product overview

Granular Restore for Microsoft Exchange and SQL is a granular data extraction software for offline SQL
databases and Microsoft Exchange Server mailbox stores and Outlook files. The utility provides direct
access to unmounted database tables and mail store contents, displaying file structure and its contents
with selective export functionality. With a search query tool, users are able to export specific queries
rather than large tables or files.

For SQL databases, recovered items can be saved as SQL scripts or exported directly to a live SQL server.
For Microsoft Exchange servers, files can be saved as Personal Storage File (.pst) files, to be opened with
Microsoft Outlook or other compatible email clients, or exported directly into live Exchange Server
mailboxes. The utility makes no changes to the store, preserving it in original unmodified state.

Main features of Granular Restore for Microsoft Exchange and SQL:

SQL Server Database

e Recovers entire tables, objects and object groups

e Recovers data obtained by specific search queries

e Recovers keys, scripts, functions, triggers and procedures

e Recovers default settings, user types and views

e Saves single or multiple points of data as SQL scripts or exports to live SQL database

Exchange Server

e Recovers mailboxes, folders, messages and file attachments
e Recovers notes, contacts, tasks and appointments
e Recovers creation dates for all objects

e Saves selected items to PST files or exports to live Exchange Server mailbox(es)

1.1 Supported Exchange database versions

Granular Restore for Microsoft Exchange and SQL supports the following mail store versions: Exchange
2016, Exchange 2013 SP1, Exchange 2010 SP3 and Exchange 2007 SP3
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1.2 Supported Outlook versions

Granular Restore for Microsoft Exchange and SQL supports the following versions of PST/OST files: 2013
and 2010

1.3 Supported SQL Server database versions

Granular Restore for Microsoft Exchange and SQL supports the following versions of MDF files: 2014,
2012, 2008R2, 2008 and 2005

1.4 System requirements
Basic system requirements:

Operating systems: Windows 10, Windows 8.1, Windows 8, Windows 7, Windows Server 2012 R2,
Windows Server 2012, and Windows Server 2008

RAM: 1024MB, depends on store size and OS version

Hard Disk: minimum 50MB of free space required for installation Display: 800 x 600 or higher resolution,
256 colors

Additionally, Granular Restore for Microsoft Exchange and SQL may require free space on disk 1.5x the
size of mail store being processed. For example, for 300MB store, 450MB free space should be available.
Live Exchange Server export requirements

Exchange Server
Exchange Server 2016, 2013, 2010 or 2007

Exchange Web Services enabled on Exchange Server

Network

Port 443 open on the network. The EWS messages are transported via SOAP-based API, which is
essentially sending XML data using https protocol.

Restore client

Granular Restore for Microsoft Exchange and SQL installed. Access to Exchange server(s) over network.

Live SQL Server export requirements

SQL Server
SQL Server 2014, 2012, 2008R2, 2008 or 2005

SQL Server Browser running on SQL Server
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Network

To establish connection to live SQL Server, remote network access must be allowed on the server and
TCP/IP protocol must be enabled in SQL Server Configuration Manager. For detailed instructions on how
to do it, visit http://blogs.msdn.com/b/walzenbach/archive/2010/04/14/how-to-enable-remote-
connections-in-sql-server- 2008.aspx

Restore client

Granular Restore for Microsoft Exchange and SQL installed. Access to SQL Server(s) over network.

1.5 Limitations
The current version of the product has the following limitations:
e Simultaneous recoveries are not supported.
e Simultaneous running of more than one instance of the product is not supported.

e Usage in "Run as different user" mode is not supported.

SQL Server Limitations

e Log files are not processed.
e Encrypted SQL databases are not currently supported.

e C(Calculated fields and fields of type [sgl_variant] in indexes cannot be used in SQL database
search.

e Sparse columns in SQL databases are not supported.
e Filestream data type and Filetables in SQL databases are not currently supported.

e Searching by 'real' data type may return not full results.

Exchange Server Limitations

e Encrypted emails are not restored.

e Messages in the Outbox folder are not restored if they haven't been synchronized with the

server.
e Messages with size over 64MB are not supported
e Recovery of delivery receipts and non delivery reports is not supported.

e OST files, created in Outlook 2013, are not supported.

Page 6


http://blogs.msdn.com/b/walzenbach/archive/2010/04/14/how-to-enable-remote-connections-in-sql-server-2008.aspx
http://blogs.msdn.com/b/walzenbach/archive/2010/04/14/how-to-enable-remote-connections-in-sql-server-2008.aspx
http://blogs.msdn.com/b/walzenbach/archive/2010/04/14/how-to-enable-remote-connections-in-sql-server-2008.aspx

Granular Restore for Microsoft Exchange and SQL 8.0 User Guide

Password-protected PST files are not restored in command-line interface Command-line
interface is not supported for MDF files.

Injection limitations for Exchange Server

Archived mailboxes (and items from such mailboxes) are not exported to live Exchange
Server. Photos of contacts are not exported to original live mailbox in Exchange Server 2007.

Emails with embedded images are displayed with an attachments icon after exporting into
live Exchange Server 2007.

Creation time and modified time are not restored. Exporting data into live public folder is not
supported.

Exporting data from PST/OST files into original mailbox is impossible.

Contact groups and meeting requests cannot be exported into live Exchange Server 2007
instances. Use export through PST for these item types.

Missing sent date is exported as current date/time into live Exchange Server.

Limitations for search in attachments content (available for EDB/PST/OST files)

Search in attachments does not work for:

Tip

Text contained in embedded OLE objects, WordArt and smart objects, charts etc. Documents
metadata (author, comments, tags etc.).

Marker symbols in lists (numbered or bulleted). Text in header/footer.

XLS/XLSX: number values, formulas, cell comments. PPT: tables content.

Note that the utility is best used for granular item extraction. The user interface of the program is
designed for ease of locating, selecting and exporting specific messages, folders or mailboxes. Entire
databases can be exported as well, but the restore time will significantly increase over a slow connection.
For bulk operations that involve exporting more than one mailbox it is typically better to work with a local
copy of the database.

1.6

Boundaries for optimal recovery and search

Usage of Granular Restore for Microsoft Exchange and SQL is optimal for files that do not exceed:
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EDB:

EDB size: 2TB Mailbox size: 100GB

Number of messages in the EDB file: 2,000,000 Number of mailboxes in the EDB file: 2,000 Number of
messages in one mailbox: 100,000

PST/OST:

PST/OST size: 100GB

Number of messages in the PST/OST file: 200,000 Number of folders in the PST/OST file: 1,000 Number
of messages in one folder: 100,000

MDF:

MDF size: 1TB

Number of tables in the MDF file: 1,000 Number of rows in one table: 10,000,000

1.7 Customer support

For customer support, please contact EVault using one of the methods listed below.

Online: https://www.evault.com/support/customer_login.html
email: Support@EVault.com
Tip

When contacting customer support with a technical issue, please have ready the program's log files and
the store you are having difficulty with.

To get log files, click File menu and choose Open log folder. Zip the contents of the folder and attach the
resulting archive to your support request.

If the log archive and/or mail store exceeds 10MB, it may be impossible to send them as an email
attachment. In that case, upload instructions will be provided to you upon request.
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2 Installation

This chapter describes the steps required to install Granular Restore for Microsoft Exchange and SQL.

Depending on your preferences, it is possible to install the product in default or advanced mode.

Default mode

Default mode provides simple setup that requires just a few mouse clicks to complete. For the sake of

simplicity, it does not offer any customization capabilities and uses the following default settings:

Granular Restore for Microsoft Exchange and SQL will be installed in a per-user folder and be available

just for your user account. You do not need local administrator privileges in this case.

The default installation location is "C:\Program Files\EVault Software\" A shortcut for this program will
be created on the desktop automatically.

Step by step instructions:

1. Double-click on the setup file to start the installation process.
2. The Software License Agreement appears. Read it and accept the terms in the License Agreement.

Granular
Restore

for Microsoft®
Exchange
and SQL

E EVault”

Print

15 Granular Restore for Microsoft Exchange and SQL Setup — = Bl

Granular Restore for Microsoft Exchange

End User License Agreement

THIS IS A LEGAL AGREEMENT
(“AGREEMENT") BETWEEN YOU AND
EVAULT, FROM CARBONITE.

(“LICENSOR”). PLEASE READ THIS
AGREEMENT CAREFULLY. BY CLICKING
THE "I ACCEPT" BUTTON OR TAKING ANY
STEP TO DOWNLOAD, SET-UP, INSTALL v

[¥]1 accept the terms in the License Agreement

Click Install to install the product with default options just for
you. Click Advanced to change installation options.

, Advanced Cancel

3. Click Install to start setup .
4. The installation will start. When finished, you will have an option to launch the installed product.
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Advanced mode

Advanced setup mode allows changing default installation options. Step by step instructions:

1. Double-click on the setup file to start the installation.
2. The Software License Agreement appears. Read it and accept the terms in the License Agreement.

Granular
Restore

for Microsoft®
Exchange
and SQL

S

Print

15 Granular Restore for Microsoft Exchange and SQL Setup = = Il |

Granular Restore for Microsoft Exchange

End User License Agreement

THIS IS A LEGAL AGREEMENT
(“AGREEMENT”) BETWEEN YOU AND
EVAULT, FROM CARBONITE.

(“LICENSOR”). PLEASE READ THIS
AGREEMENT CAREFULLY. BY CLICKING
THE "I ACCEPT" BUTTON OR TAKING ANY
STEP TO DOWNLOAD, SET-UP, INSTALL v

[V]1 accept the terms in the License Agreement

Click Install to install the product with default options just for
you. Click Advanced to change installation options.

\ Install { Advanced ' Cancel

3. Click Advanced to change installation options described above.
4. Click Next to install the product to the default folder or Change to choose another folder. To add an
icon shortcut to the desktop for quick start of the program, check Create a shortcut for this program

on the desktop.
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Destination Folder
Click Next to install to the default folder or dick Change to choose another. @

Install Granular Restore for Microsoft Exchange and SGL to:

IC:\Program Files (x&6)\EVault Software),

Create a shortcut for this program on the desktop.

5. Click Install to begin the installation. Click Back to change any of your installation settings. Click
Cancel to exit the setup wizard.

6. After the installation finishes you can choose to Launch Granular Restore for Microsoft Exchange and

SQL when setup exits to start the program automatically by clicking the appropriate checkbox. Click
the Finish button to exit the setup wizard.

2.1 Product activation

When starting Granular Restore for Microsoft Exchange and SQL for the first time, you are prompted to
activate the product by entering your license key.

Enter the license key, and provide the names of registered user and company. Click Next to finish the
activation.

Note: If you enter an old license key, or continue to use an old license key after an upgrade, only
Exchange restores will be available. To obtain the correct license key, contact your service provider.
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Enter license key Confirmation
Enter license key and registration information.
License key: Enterthe License key, supplied after the purchase
MName: Enter your name
Company: Erterthe name of the company {lzave blank if the program will be used for personal needs)
Help Cancel Previous Neat

Tip

When getting an error message, first of all check if the license key has been entered correctly. It's best to
copy and paste the key to avoid typos.

2.2 Product deactivation

Deactivation of the product should be used before product uninstallation. Follow the steps below for
successful deactivation:

1. Start the product. Go to the Help menu, click License manager.

Help |

Contents and index F1

Go to customer support enling

Go to Granular Restore for Microsoft Exchange web site

License manager

About

2. Select Deactivate product license for this computer in the opened window and click Next.
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3. Enter your license key

Enter license key Confirmation

Enter license key.

License key: irour license key will be automatically displayed in this field.
Name: |lzer Name
Compary: Company

4. Click Next to finish the deactivation.
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3 Opening a file

To directly open a file for browsing and export, launch Granular Restore for Microsoft Exchange and SQL
and click file open button on the taskbar or select File| Open from the menu. On first launch, the file
open dialog will be shown automatically.

Select the store you will be working with and click Open.

Loal in: | || Bxchange Server Database V| 9 [_’: = '

~

Mame Date modified Type

-
el =2 Mailbox Database 371373014 3:51 AM . Exchange Server .
Recent places

Desktop

Libraries

File name: | Mailbox Database W |

Files of type: |.NI supported formats (*edb, * pst, *.ost, *mdf, *bak) W |

Path to log files: | || Browse... |

By default, a progress window will accompany opening the selected file. The window displays overall
progress and information about the number of items and objects in the file (1). The window can be
disabled by unchecking the Show the dialog next time check box (2) or from the Options menu. The
progress window will be automatically closed in 3 seconds after database opening (3).

Page 14



Granular Restore for Microsoft Exchange and SQL 8.0 User Guide

The current operation can be cancelled right on the progress dialog, by clicking an appropriate link.

After loading the file is complete, it will be available for browsing and export. The opened store will also
become the default store and will be automatically reopened next time you launch the utility.

Opened database can be reloaded with database log files. Go to the File menu and select Reload
database using transaction logs.
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Q

File | Options Help

Openfile... Ctrl+0

Recent Select mailboxes or folders to search

Closefile

=

neload database using transaction logs

Search for files to open... ilbox Database.edb

Export selected iterns into P3T... Ctrl+5
’ ; o ) Exchange Server Database\Maibox Database.edb
Export into eriginal Exchange mailbox...  Ctrl+G 2 904 Mb

Cancel current operation Ctrl+N ite: 3/13/2014
rsion: Exchange Server 2013
Open log folder

Delete saved temp files and logs ansaction logs not used.

Bt maiboxes. Select a mailbox to display folders.

= il . . .
-] 5 Maria Woods Load time: 00:00:04

-] &9 Michael
Dﬁ Personal Archive - HealthMailboxade Sae et

-] £ Personal Archive - HeatthMaiboxbaaB042260
- [] 59 Richard

-] Robert Rise

-] 5§ Romeo Montague

0[] Rudy Raid

[ ]9 Susane Tyler

Dﬁ SystemMailbox {ade9ae -2 0b5-4860-a1cf-021
- ]9 Tim Goodler

File info

£
Completed

Note

If you closed the progress window, it can easily be shown again by clicking on the progress bar on the

status panel.

3.1 Finding a file

In case when the location of the file is unknown, it is recommended to scan existing drives to find the
data. Granular Restore for Microsoft Exchange and SQL scans local drives, as well as network drives and
searches for PST/OST, MDF and EDB files.

To start a new search click Search for files to open in the File menu.
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File | Options Help

Open file... Ctrl+O
Recent
Close file

Reload database using transaction logs

Ctrl+S
Ctrl+G
Ctrl+N

Export selected itemns into PST...
Export into original Exchange mailbox...

Cancel current operation

Open log folder
Delete saved temp files and logs

Exit

Select maiboxes or folders to search

ilbox Database.edb

Exchange Server Database\Maibox Database.edb
e: 904 Mb

ite: 3/13/2014

rsion: Exchange Server 2013

rnsacljon logs not used.

mailboxes. Select a maibox to display folders.

T

[-[_]£9 Maria Woods

1-[_] &5 Michae!
Dﬁ Personal Archive - HeathMailboxade3ae Febb
[]£J Personal Archive - HeathMailboxbaa80426260

]9 Romeo Mortague

[J&9 Rudy Raid

159 Susane Tyler

[J£) SystemMailbox{adeSae F-25b5-4860-a1cf-021

Dﬁ Tim Goodler

£

Load time: 00:00:05

] File info |

Completed

The following form appears, displaying the list of mounted disks:

[ al Disk (C:)
] —a New Volume (E2)

File types by application:
Exchange Server (" edb)

Outlook {*pst, = ost)
SAL Server (*mdf, *bak)

Custom match:
|ExE|n1p|e: *edb;” ost

Add location to search...

Found files:

Filter: | Al

File

Date created Date modified

Type

Open file

Start search
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Select a location to search in.

File types by application:
™ Local D Exchange Server (*.edb)

= New Volume (E2) Outlook {* pst, *ost)
SQL Server (*.mdf, * bak)

Custom match:

|ExE|n1p|e: *edb;” ost

Add location to search...

Filter: | Al

Found files:

File Date created Date modified Type

Open file

List of found files will be displayed. Double-click a file to open it.
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Select source: File types by application:
[¥] & Local Disk (C) Exchange Server (*.edb)
[¥] = New Volume (E:) Outlook (*pst, ~ost)

SQL Server (*.mdf, *bak)

Custom match:
IExampIe: *edb;”.ost

Found files: Filter: |AII

File Size Date created Date modified Type

C:\Exchange Server Database\Mailbox Database.edb 304 MB 11/30/2015 3/13/2014 Exchange Server (*.edb)
C:A\DRTC_S\DREXATest\Script\AddFunctions sjbak  37.6 KB 8/18/2015 11/30/2015 SQL Server (*.mdf, *bak)
CADRTC_S - Copy\DREXATes...\AddFunctions sj.bak 37.6 KB 12/8/2015 11/30/2015 SQL Server (*.mdf, *bak)
C:\Windows\SoftwareDistribution\Da...\DataStore.edb 84.0 MB 11/25/2013 12/9/2015 Exchange Server (".edb)
C:\ProgramData\Microsoft\....\PackageRepository.edb 24.0 MB 11/25/2013 12/9/2015 Exchange Server (*.edb)
C:\Program Files {x86)\SmartBear...\tcFFHook xmlbak 21.0 KB 6/24/2015 6/24/2015 SQL Server (" mdf, * bak)
C:\Users\All Users\Microsof...\PackageRepository.edb 24.0 MB 11/25/2013 12/9/2015 Exchange Server (*.edb)
C:\ProgramData\Microsoft'Search'\D...\Windows.edb 72.0 MB 11/25/2013 8/17/2015 Exchange Server (".edb)
C:\Users\Administrator\....\appsFolder.temdata-ms bak 62.3 KB 3/13/2014 12/8/2015 SQL Server {*.mdf, *bak)

. —

Search complete. 16 file(s)found. | Cearlistandsearchagan | |  Bxt
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4 Granular Restore for Microsoft SQL

4.1 Finding and browsing data

In general, Granular Restore for Microsoft Exchange and SQL provides two modes of processing file data:
browsing the file tree and search. Using these, it is possible to efficiently form a set of objects for
subsequent export, including the necessary ones and excluding ones to be skipped.

A newly opened database is shown in the Browse mode.

File  Options Help

= I
=t

Browse Destination
B[ Jey AdventureWorks2012_C5_Data mdf )
BDE Programmabilty (2] Tables Mo live servers connected.

[JC3 Functions (11) Connect to a live serverto enable
[(JE3 Procedures (10} 71 objects. select an object to dEDlaY data. export of objects from source storage.
[JEa Rules (0}
[CJE3 User Types (6}
(] Tables (71)

[IEg Views (20)

Folder info

Completed

Browsing database tree

Browse mode shows database in a tree-like structure and allows browsing folders and previewing
individual objects.

This mode is best for navigating to a specific object, when it is precisely known what data needs to be
extracted.

For example, a user may ask to restore some specific table. Expand the folder 'Tables' in the tree and
select the table. Available rows will be listed to the right of the tree. Please note that product will not try
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to load all rows in table. Instead of that rows will be loaded by portions each time you navigate to the

end of list.

File  Options Help

7 H Search in Person.Address

EBrowse

[(JE3 Programmability (4)

[C1E3 Tables (71)

171 dbo AWBLildVersion (1)

[[1=] dbo.DatabaseLog (1,557}

[[17=] dbo Emorlog (0)

[[1=] HumanResources.Department (16)

[1] HumanResources Employee (250)

[[1=] HumanResources.Employse Departmen

[17=] HumanResources EmployeePayHistory

[ HumanResources JobCandidate (13)
3

W oo~ o =

- =

[C1=] Person.BusinessErtity (20,777)
[17=] Person BusinessEntityAddress (19.614)
[C1=] Person.BusinessErtityContact (309)
[17=] Person Contact Type (20)

[ Person CourtryRegion (228)
[1F=] Person EmailAddress (19.572)
[C1=] Person.Password {13,972

[1F=] Person Person (19.572)

[C1=] Person.PersonPhone (19.572)
[17=] Person.PhoneNumberType (3)
[C1=] Person.StateProvince (181}

[1F=] Production Bil Of Materials (2.675)
[ Production.Cutture (2)

[17=] Production Document (13}

[C1=] Production. llustration (5)

<

B[ Jey AdventureWorks2012_C5_Data mdf AddressID

AddressLine1

1970 Napa Ct

5833 M. Dias Blv.
7484 Roundtree Drive
9539 Glenside Dr
1226 Shoe 5t

1399 Firestone Drive
5672 Hale Dr.

6387 Scenic Avenue
8713 Yosemite Ct.
250 Race Court
1318 Lasalle Street
5415 San Gabriel Dr.
9265 La Paz

8157 W. Book

4512 La Vuelta

40 Eliis 5t.

6696 Anchor Drive
1873 Lion Circle
3148 Rose Strest
6872 Thomwood Dr.
5747 Shirey Drive
636 Vine Hill Way
6657 Sand Pointe Lane
80 Sunview Temace
9178 Jumping St
5725 Glaze Drive

AddressLine2

NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL

City
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Portland
Seattle
Duluth
Dallas
San Francisco

e R s R v R i R R e = e R i R R i R R e R

Mo live servers connected.

Connect to a live serverto enable
export of objects from source storage.

Completed

In case if SQL script of a table is necessary, just right-click on the table in the database tree and select

'Show SQL script' in the context menu.
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File  Options Help

& &

Browse

=-[Jug AdvertureWorks2012_CS_Data mdf
I3 Programmability (4}
=-[]E3 Tables (71)

£

Search in Person Address

1] dbo.AWBLilVersion (1)

[[1=] dbo Databaselog (1.557)

(1] dbo.Erorleg (0)

[[1F=] HumanResources Department (16}
[ HumanResources. Employse (250)
[1=] HumanResources Employse Departmert
[[1=] HumanResources.EmployeePayHistory
[1=] HumanResources JobCandidate (13)
[[1=] HumanResources.Shift (3

Show S0OL script
[C1=] Person.BusinessErtityAddress (19.514)
[17=] Person BusinessEntityContact (303)
[C1=] Person Contact Type (20)
[1F=] Person CourtryRegion (238)
[ Person.EmailAddress (19.972)
[17=] Person Password (19.572)
(=] Person.Person {19,972}
[1F=] Person PersonPhone (13.572)
[C1=] Person.PhoneNumberType (3}
[1F=] Person StateProvince (181)
[ Production.BilCfMaterals (2,673)
[[17=] Production Cutture (8)
[ Production.Document (13}
[17] Production llustration (5)

AddresslD  Addresslinel

1570 Napa Ct

5833 M. Dias Blv.
7484 Roundtree Drive
9539 Glenside Dr
1226 Shoe 5t

1399 Firestone Drive
5672 Hale Dr.

6387 Scenic Avenue
8713 Yosemite Ct
250 Race Court
1318 Lasalle Street
5415 San Gabriel Dr.
9265 La Paz

8157 W. Book

4912 La Vuelta

40 Eliis St.

6636 Anchor Drive
1873 Lion Circle
3148 Rose Strest
6872 Thomwood Dr.
5747 Shirey Drive
636 Vine Hill Way
6657 Sand Pointe Lane
80 Sunview Temace
5178 Jumping St.
5725 Glaze Drive

=R R R R L

AddressLine2

NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL

City
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Portland
Seattle
Duluth
Dallas
San Francisco

bR B Qv e e R R i R e e i i e i R e R R

w

Mo live servers connected.

Connect to a live serverto enable
export of objects from source storage.

Completed
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Any particular row can also be scripted via context menu. By right click on the row, SQL script can be
either shown or at once copied to clipboard.

File  Options Help

~
r—d H Search in Person.Address
Browse

=-[]e) AdventureWorks2012_CS_Data.mef AddressID  AddressLine1 Addressline2  Ciy
- ]C3 Programmbilty (4) 1970 Napa Ct NULL Bothel

E-[JEa Tables (71) 5833 Mt. Dias Biv. NULL Bothell

I dbo AWBuildVersion (1) ]
[ dbo DatabaseLog (1.557) 7484 Roundiree Drive NULL Bothell
9539 Glenside Dr NULL Bothell

[[17=] dbo Emorlog (0)
[[1=] HumanResources.Department (16) 1226 Shoe St. NULL
[1] HumanResources Employee (250) 1399 Firestone Drive NULL
[[1=] HumanResources.Employse Departmen 5672 Hale Dr. NULL
[17=] HumanResources EmployeePayHistory 6387 Scenic Avenue NULL
[ HumanResources JobCandidate (13)
[[1] HumanResources Shift (3)
P s (5610

[1=] Person MdressType (6)
[C1=] Person.BusinessErtity (20,777)
[17=] Person BusinessEntityAddress (19.614)
[C1=] Person.BusinessErtityContact (309)
[17=] Person Contact Type (20)
[ Person CourtryRegion (228)
[1F=] Person EmailAddress (19.572)
[C1=] Person.Password {13,972
[1F=] Person Person (19.572)
[C1=] Person.PersonPhone (19.572)
[17=] Person.PhoneNumberType (3)
[C1=] Person.StateProvince (181}
[1F=] Production Bil Of Materials (2.675)
[ Production.Cutture (2)
[17=] Production Document (13}
[C1=] Production. llustration (5)

Mo live servers connected.

Connect to a live serverto enable
export of objects from source storage.

L= B R R L

Copy 50L script to clipboard

Show SOL script

Search for similar data

Search for data related to [AddressID]

4512 La Vuelta NULL Bothell
40 Eliis 5t. NULL Bothell
6696 Anchor Drive NULL Bothell
1873 Lion Circle NULL Bothell
3148 Rose Strest NULL Bothell
6872 Thomwood Dr. NULL Bothell
5747 Shirey Drive NULL Bothell
636 Vine Hill Way MULL Portland
6657 Sand Pointe Lane NULL Seattle
80 Sunview Temace NULL Duluth
9178 Jumping St NULL Dallas
5725 Glaze Drive NULL San Francisco

ﬁ%EQEEEEEEEEEEEEEEEEEEEEE

AEBFENNNNssd s RS

<

v

Completed

Rows filtering provides the ability to easily find specific values in tables. To enable filtering, just start
typing necessary data, when focus is on the list or press Ctrl+F keys. Please note that rows filtering
works only for rows that was already loaded in current view.
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File  Options Help

/ f“7 H Search in Person Address
Browse

E||:| v# AdvertureWorks2012_CS5_Data mdf AddresslD AddressLine1 Addressline2 ity
Eg i:fle':”‘lff}b"“ “ 6872 Thomiweod Dr. NULL Bothel
1] dbo.AWBLilVersion (1) 5669 lroniwood Way NULL Kenmore
[J=] dbo Databaselog (1.557) 531 Mermiewood Drive NULL Snohomish
7726 Driftwood Drive NULL Monroe

(1] dbo.Erorleg (0)
(] HumanResources Department (16) 9653 Mellowood Street NULL Duvall

Mo live servers connected.

Connect to a live server to enable
export of objects from source storage.

[ HumanResources. Employse (250) 350 Ridgewood Ct. NULL Camation
[1=] HumanResources Employse Departmert
[[1=] HumanResources.EmployeePayHistory
[1=] HumanResources JobCandidate (13)
[[1=] HumanResources.Shift (3

[ Peon A (15610

[C1=] Person.Address Type (5)

[17=] Person BusinessEntity (20.777)

[C1=] Person.BusinessErtityAddress (19.514)

[17=] Person BusinessEntityContact (303)

[C1=] Person Contact Type (20)

[1F=] Person CourtryRegion (238)

[ Person.EmailAddress (19.972)

[17=] Person Password (19.572)

(=] Person.Person {19,972}

[1F=] Person PersonPhone (13.572)

[C1=] Person.PhoneNumberType (3}

[1F=] Person StateProvince (181)

] Production BilCMaterials (2.673) fwodl | [where:

[[17=] Production Cutture (8)
Production. Document (13) . | 4 e

EE Production llustration (5) Seleet e iens

£ £

Completed

Using search

Granular Restore for Microsoft Exchange and SQL provides several ways to search for data:
e Standard search
e Search for related data

e SQL Query search

To access the Search tool, select a table where the search will be performed and click on the Search Bar

(1) located at the top of the window.
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File

Options  Help

& &

Browse

=-[Jug AdvertureWorks2012_CS_Data mdf

£

Feart:h in Person. Address

I3 Programmability (4}

=-[]E3 Tables (71)

1] dbo.AWBLilVersion (1)
[[1=] dbo Databaselog (1.557)
(1] dbo.Erorleg (0)
[[1F=] HumanResources Department (16}
[ HumanResources. Employse (250)
[1=] HumanResources Employse Departmert
[[1=] HumanResources.EmployeePayHistory
[1=] HumanResources JobCandidate (13)
[[1=] HumanResources.Shift (3

=] Person Address (19.614)
[C1=] Person.Address Type (5)
[17=] Person BusinessEntity (20.777)
[C1=] Person.BusinessErtityAddress (19.514)
[17=] Person BusinessEntityContact (303)
[C1=] Person Contact Type (20)
[1F=] Person CourtryRegion (238)
[ Person.EmailAddress (19.972)
[17=] Person Password (19.572)
(=] Person.Person {19,972}
[1F=] Person PersonPhone (13.572)
[C1=] Person.PhoneNumberType (3}
[1F=] Person StateProvince (181)
[ Production.BilCfMaterals (2,673)
[[17=] Production Cutture (8)
[ Production.Document (13}
[17] Production llustration (5)

Address|D

=R R R R L

- =

Addressline1

1570 Napa Ct

5833 M. Dias Blv.
7484 Roundtree Drive
9539 Glenside Dr
1226 Shoe 5t

1399 Firestone Drive
5672 Hale Dr.

6387 Scenic Avenue
8713 Yosemite Ct
250 Race Court
1318 Lasalle Street
5415 San Gabriel Dr.
9265 La Paz

8157 W. Book

4912 La Vuelta

40 Eliis St.

6636 Anchor Drive
1873 Lion Circle
3148 Rose Strest
6872 Thomwood Dr.
5747 Shirey Drive
636 Vine Hill Way
6657 Sand Pointe Lane
80 Sunview Temace
5178 Jumping St.
5725 Glaze Drive

AddressLine2

NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL

City
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Portland
Seattle
Duluth
Dallas
San Francisco

bR B Qv e e R R i R e e i i e i R e R R

w

Mo live servers connected.

Connect to a live server to enable
export of objects from source storage.

Completed

Search results will be displayed on separate tabs with the ability to select query results and export them

either into Live SQL Server or in the form of SQL script files which can be executed on server manually.
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File  Options  Help

.“—nj—, I | Search in Person Address

AddressID Addresslinel Addressline2  City StateProvincsIC ™

1570 Napa Ct MNULL Bothell
5833 Mt. Dias Blv. MNULL Bothell
7484 Roundtree Drive MNULL Bothell
9533 Glenside Dr MNULL Bothell
1226 Shoe St. MNULL Bothell
1399 Firestone Drive NULL Bothell
5672 Hale Dr. MNULL Bothell
6387 Scenic Avenue NULL Bothell
8713 Yosemite Ct MNULL Bothell
250 Race Court MNULL Bothell
1318 Lasalle Street MULL Bothell
5415 San Gabriel Dr. MNULL Bothell
9265 La Paz MULL Bothell
8157 W. Book MNULL Bothell
4912 La Vuelta MULL Bothell
40 Hlis 5t. MNULL Bothell
6696 Anchor Drive MULL Bothell
1873 Lion Circle MNULL Bothell
3148 Rose Strest MNULL Bothell
6872 Thomwood Dr. MNULL Bothell
5747 Shirey Drive MNULL Bothell
1502 Santa Cruz MNULL Bothell
99300 223rd Southeast MNULL Bothell
25111 228th 5t Sw MNULL Bothell
5509 Newcastle Road NULL Bothell
7057 Striped Maple Court MULL Bothell

Mo live servers connected.

Connect to a live serverto enable
export of objects from source storage.

:—c‘tﬂwﬂd‘}m&-ml\.i—‘

drdddddddddddddddddddBdE P

Completed

Standard search mode

To access Standard search click on the Search Bar and select 'Standard search' tab in the displayed
window.
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a Granular Restore for Microsoft Exchange and SQL = =

File  Options Help

3 B

= Search in Person Address p E -
Please enter search parameters
Browse Destination
=[]y AdvertureWorks2012_CS_Data mdf ~ )
éd Programmabitty (4 Standard search Related data sQL e ET L

H — i
=-[]E3 Tables (71) Fields to search: Connect to a live serverto enable

..... E: ::uggagﬂd\ff:m: ,‘_:1;_‘ () Alindexed fislds @® Custom (ndexed orly) 9) export of objects from source storage.
..... o abaselog (1.557)

..... 1] dbo.EmorLog (0} () Allfields
..... [[17] HumanResources Department |
----- [~ HumanResources.Employse |
..... [1=] HumanResources Employse Departmert

Mutltiple field match type:

..... [ HumanResources Employss PayHistory ) OR., records with one or more matching fields @)

----- [ HumanResources JobCandidate (12) (Z) AND. records with matches in all searched fields

----- [ HumanResources.Shift (3}

..... D‘='] Fields:

----- [C1=] Person.Address Type (5) =

[[1F=] Person BusinessEntity [ AddressiD @)
] 1 [[] Addressline1

[] Addressline2
[ ciy
[[] StateProvincelD

[[] PostalCode

Prefill Search Clear

T T ULITIEITg oD vanas T

5725 Glaze Drive NULL San Francisco 9/ ¥

£
Completed

There are three sets of parameters to customize for this search:

Fields to search (1)

This options defines the set of fields which will be used to perform search. The user can choose to
search in all indexed fields, all fields, custom selection from indexed fields or custom selection from all
fields.

Multiple field match type (2)

In case more than one field is selected for search the user can choose which logical operator will be used
to combine these fields.

OR - search results will include records which have at least one field that matches search parameters.
AND - search results will include records which have matching values in all fields which were selected for
search.

Fields (3)

If Custom (indexed only) or Custom was selected in Fields to search the user will be able to choose fields
which will be used for search. To select a field simply click on the field name, the field will then become

selected and the user will be able to choose which comparison operator to use and to enter the value to
search for.
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There are also two ways to fill search fields with values from selected tow, which helps to avoid entering
long string manually:

Right-click on a row and select Search for similar data from context menu. This fill set the field selection
to Custom and fill search from with values from selected row.

OR

Select a row, then select Standard search tab and click Prefill button.

Search for related data

Search for related data can be used to search for rows which relate to the selected row - that are rows
which have fields from the selected table as foreign keys.

Related data search can be accessed either by right-clicking on a row and selecting Search for data
related to... from context menu or by selecting Related data tab in search window.

@ Granular Restore for Microsoft Exchange and SQL = B
File  Options Help

~u

7= Search in Person.Address p =g -
Flease enter search parameters.
EBrowse Diestination
E-[]4) AdventureWorks2012_CS_Data mdf ~ Standard search Related data SaL -
-] Programmbiity () = = Mo live servers connected.
E|'"’:||_£|la_]b|93 (71) ( Fields: ) Connect to a live server to enable
----- dbo AWBuildVersion (1) export of objects from source storage.
AddressID
..... ] dbo.DatabassLog (1,557) ress (1)

..... [[17=] dbo Emorlog (0} .
----- [ HumanResources.Department (16) Related tables:

_____ (] HumanResources Employee (250) Person.BusinessErtityAddress [Address|D]
----- [[1=] HumanResources.Employse Departmen
..... [17=] HumanResources EmployeePayHistory
----- [ HumanResources JobCandidate (12)
..... [1=] HumanResources Shift (3}

----- B[] Foron hthess (15614)

[1=] Person AddressType (5)

Sales.SalesOrderHeader [Bil ToAddress|D]; [ShipToAddress|D]

..... [1=] Person PhnneNumher“I’)’p 3 \ 4

----- [ Person.StateProvince (181}

..... == Prndu:t?nn BiIIOfMa?e\rials (2679 Prefill Search Clear

----- [ Production Culture (8)

----- [17=] Production. Document (13} = JrrGrenmpg o o Caas =

----- [ Production. llustration (5) v |26 5725 Glaze Drive NULL San Francisco 9/ ¥
£ > £ >

Completed

The application will analyze the selected table and automatically detect which fields are used in other
tables as foreign keys (1). It will also provide a list of tables which relate to the selected table (2).

The user will then be able to enter field values which will be used when searching for related data and
select from a list of tables where to perform search.
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SQL Query mode

SQL Query search mode provides the ability to write complex search queries using SQL-like query
language to narrow search results as much as possible.

SQL query mode can be accessed by clicking on Search Bar and selecting SQL tab.

a Granular Restore for Microsoft Exchange and SQL = =

File  Options Help

~u

7 Search in Person.Address p @ -
Please enter search querny
Browse Destination
<[] wd AdventureWorks2012_CS_Data mdf
= tlfh__] Programmabiity P ~ Standard search Related data sQL e ET L
E-[]C3 Tables (71) . SELECT * FROM Person.Address WHERE Connect to a live server to enable
----- (1] dbo.AWBuildVersion (1) ~ export of objects from source storage.
..... []F=] dbo.DatabaseLog (1.597) o_)

----- [[1=] dbo.EmorLeg (0)

..... [[17=] HumanResources Departme:
----- [ HumanResources Employse
..... [1=] HumanResources Employse Departmert
----- [[1=] HumanResources.EmployeePayHistory
..... [[1=] HumanResources JobCandidate (13}
----- [ HumanResources.Shift (3}

----- B[] Poon Adss (19614

..... [C1=] Person.Address Type (5)

©)

Please enter the remaining part of the query to search for data.

1) Department="Engineering’ AND Age=42

2) Name="Steve’ OR Salary>=100000

3) (Department="Marketing' OR Position="Intem’) AND Age<30

4) Salary=100000 OR ({Department="Engineering’ AMD [YearsOf Service<5 OR
LPos'rti0n='Inham',‘s}

Prefill Search Clear

= STrERLTPIng ot vanas =
----- [17=] Production llustration (5) v |26 5725 Glaze Drive NULL San Francisco 9/ ¥
£ > £ >

Completed

The user is presented with a text field (1) which is used to enter search query. The beginning of the
query is given and the user has to fill in the remaining part of WHERE clause.

The query may include field names, comparison operators, field values, logical operators and brackets.
The text field makes it easier for entering search query by providing auto-complete feature, which
automatically suggests possible query elements. The auto-complete window will appear automatically
when first letters of query are typed, it can also be accessed by pressing Ctrl+Space. To select an item
(field name, logical or comparison operator) from the list please press Tab or Enter.

Query examples are given at the bottom of the SQL tab (2).

4.2 Exporting items

Granular Restore for Microsoft Exchange and SQL allow a user to export the whole database or just
particularly objects (tables, views, functions, etc.) into live SQL Server and to SQL scripts, that can be
used for manual import to a live server.
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Restore to live SQL Server

Granular Restore for Microsoft Exchange and SQL includes the injection capability for items (tables,
views, functions, etc.) from offline database to live SQL database.

Note: Errors can occur when you try to restore data that violates SQL constraints (e.g., primary
key/foreign key constraints).

The following options are presented:
e Authentication

e Connection to a database using valid credentials. To provide the connection, host (domain
name or IP), user logon name and password are required. It is also possible to connect
through current Windows credentials.

e Connecting to several tables on different servers simultaneously.

e Browsing folder hierarchy of a connected database, browsing folder contents and viewing
objects and rows.

e To provide injection, running the application as administrator or using a machine from AD
domain, in which there is SQL Server with destination database, is not required.
Connection to SQL Server

To establish a new connection, use the button Connect to live server (1), next to the Search field or go
to File -> New connection->Attach to live SQL Server database (2).
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File | Options Help

Open file... Ctrl+0

Recent

Close file

MNew connection

Search for files to open... Mo live servers connected.
Recent

Connect to a live serverto enable
r- export of objects from source storage.
Export into live server... Ctrl+E iidserver\Testing\TestCases\msr\Sample\AdventureWorks2012_CS\2
Cancel current operation Ctrl+N e: 188 Mb

te: 5/21/2012
esplgiokiey rsion: SQL Server 2012
Delete saved temp files and logs

Save selected objects into SOL scripts...  Ctrl+5

tables. Select a table to display records

et time: 00:00:14

T wr

[17=] Person Address (19.614)

[C1=] Person.Address Type (5)

[17=] Person BusinessEntity (20.777)

[C1=] Person.BusinessErtityAddress (19.514)
[17=] Person BusinessEntityContact (303)
[C1=] Person Contact Type (20)

[1F=] Person CourtryRegion (238)

[ Person.EmailAddress (19.972)

[17=] Person Password (19.572)

(=] Person.Person {19,972}

[1F=] Person PersonPhone (13.572)

[C1=] Person.PhoneNumberType (3}

[1F=] Person StateProvince (181)

[ Production.BilCfMaterals (2,673)
[[17=] Production Cutture (8)

[ Production.Document (13} <
[17] Production llustration (5)

< File info

Completed

To access the server, enter the domain name or the IP address, or just click on the arrow (1) to get the
drop- down list of automatically detected servers and provide valid credentials.
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Server name (ex.: contoso.com MSSQLSERVER or 192.168.0. 55\MSSGLSERVER):

WS201250L

DEATHKOV-CMWADK
DEATKOW-CAVSQLEXPRESS
OR-ENVSERVERMORENVSS
W52008R250 150 SERVERZ008R2
WS520085QL\SALSERVER2008 pvide user

WS5201250L

The application will then fetch the list of databases
available on the tanget server.

After that you will be able to choose the desired
database from the list and connect.

[ ] Save pasaword

Database name:

List of available databases will be shown after clicking the Refresh button (1) or the arrow near the
Database name field (2), if entered credentials are correct.
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Server name (ex.: contoso .comMS5QLSERVER or 152.168.0.58\MSSQLSERVER):
‘Ws20125aL v| | Refresh

[] Usze cument Windows credentialz
Flease enter the server address and provide user

5QLS Jogin fex - userT) credertials for connection.

Rick The application will then fetch the list of databases
available on the target server.

After that you wil be able to choose the desired
database from the list and connect.

[ ] Save password

Database name:

I
AdventureWorks2012

Injection workflow

Once data has been selected, click the Export button and select an Export option.
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a Granular Restore for Microsoft Exchange and SQL = =
File  Options Help
= ) . = g
= H Search in Person. Address p =g -
Browse Destination =
=-[8] \J AdventureWorks2012_CS_Data mdf A | AddresslD  AddressLinel ~ =55 WS20125aL A | AddresslD  Addresslinel A
- ]E3 Programmaility () - E-ug AdventureWorks2012 ~
- [@]C Tables (71) 1 1570 Napa.G. 1B Programmabity (4) 1 1570 Napa.G. ML
R R 2 5833 Mt. Dias Blv. H . 2 5833 Mt. Dias Blv. ML
----- [ dbo. AWBLildVersion (1) 3 2484 Roundties D =13 Tables (71) 3 2434 Roundiree Dri NL
..... dbo.Databaselog (1.5 /#6% houndiree Un /=] dbo AWBLildVersio /705 houndires Hnve
_____ E:-]-] dbo EmarLog (0) 4 9539 Glenside Dr :-]-] dbo.DatabassLog 4 5539 Glenside Dr NL
----- [[1F=] HumanResources Department (15) 5 1226 Shoe St. ./ dbo EmorLog (0} 5 1226 Shoe St. NL
..... 1] HumanResources Employes (250) 6 1355 Firestone Driv .= HumanResources.| |6 1399 Firestone Drive NL
----- [C]FF] HumanResources EmployseDepartmen |7 5672 Hale Dr. ..[=] HumanResources | |7 5672 Hale Dr. NL
..... [[][=] HumanResources. EmployeePayHistory |8 6387 Scenic Avenu -.[=] HumanResources.| 8 6387 Scenic Avenue NL
----- [1=] HumanResources JobCandidate (13} 9 8713 Yosemite Ct ..[=] HumanResources | |9 8713 Yosemite Ct NL
----- [ HumanResources. Shift (3} 10 250 Race Court -.[=] HumanResources., 10 250 Race Court NL
WEils 1 1318 Lasalle Strest | | ¢ i =] HumanResources.! |11 1318 Lasalle Strest ML
----- [[] Person.Address Type () 12 5415 San Gabriel D | Person Address (1J8EY] 5415 San Gabriel Dr. NL
..... [ Person BusinessErtity 13 5265 La Paz [ Person AddressTyr |13 9265 La Paz NL
..... O Person_Bus?nessErrt:rtyAddress (19,614 14 8157 W. Book e Person.BusinessEn 14 8157 W. Book NL
----- [1F=] Person BuslnessErrtrty.(En\rda ( 15 4912 La Vueka -[7] Person BusinessEn |45 4912 La Vueta NL
----- [ Person Contact Type (20 ) [ Person. BusinessEn )
) 16 40 Eliis 5t. 16 40 Eliis 5t. NL
""" [J Person CountRegion 17 6696 Anchor Diive 3 Person ContactTyp |, 6696 Anchor Diive NL
""" (] Person EmaiAddres 18 1873 Lion Circle {3 Person CourtryReg | 1873 Lion Circle NL
----- = Person EmailAddre:
19 31138 Rose Street | 1 @ =] Person.Password | 19 31iE Rose Street NL
20 6872 Thomwood D | | @ =] Person Person (19, 20 6872 Thomwood Dr. NL
21 5747 Shiney Dive | | ] Person PersonPhor 2] 5747 Shitey Drive NL
» 66 Vine HllWay | | | Person Phonshuml |22 636 Vine Hil Way NL
23 6657 Sand Pointe L | | i Ll [ Person StateProvin 23 6657 Sand Pointe Lane ML
24 80 Sunview Temace | | 1 L =] Production BIOfM: |24 80 Sunview Temace NL
25 5178 Jumping St. | | i i =] Production Culture 25 5178 Jumping St. ML
w26 5725Glaze Drive v | | © i = Production Docume ¥ | 26 5725 Glaze Drive ML ¥
£ > £ > £ > £ >
Completed Selected: 1 object(s)

Granular Restore for Microsoft Exchange and SQL presents several injection modes for specified data:

Export to original object - The source object will be restored to the object listed under

Destination Object.

Export to new Object - The user may edit the Destination Object for any source object, and

the Granular Restore for Microsoft Exchange and SQL application will create a new

destination object to restore to.

Schema only - Export only the schema of the source objects. The destination object can be

edited and the schema(s) will be restored to the new destination object.

Unselect successfully exported objects - This will unselect the data objects that were

selected for export once they have been successfully exported to the live server. This will

allow the user to more easily identify which objects encountered errors and were not

exported.
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Destination database:
WS520125QL\Adventure Works2012

(Object names are valid. Click "Start’ to begin export.

Source object Destination object
EE [Person].[Address] [Person].[Address] %~ Source table found Remaove

(®) Export to original object (create f not exists) () Exportto new object () Schema only

[] Unselect successfully exported objects

Restore to SQL scripts

Note: Errors can occur when you try to restore data that violates SQL constraints (e.g., primary
key/foreign key constraints).

To save objects marked for export, click the Export selected objects into SQL scripts button on the
toolbar or select the point in the File menu.
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File  Options Help

~u

e

Browse

=[] v3 AdvertureWorks2012_CS_Data mdf
&-[ 3 Programmability (£)
EIE‘E] Tables (71}

£

Search in Person Address

1] dbo.AWBLilVersion (1)

[[1=] dbo Databaselog (1.557)

(1] dbo.Erorleg (0)

[[1F=] HumanResources Department (16}
[ HumanResources. Employse (250)
[1=] HumanResources Employse Departmert
[[1=] HumanResources.EmployeePayHistory
[1=] HumanResources JobCandidate (13)
[[1=] HumanResources.Shift (3

&[] Person Address (19.614)

-]
[C1=] Person.Address Type (5)

[17=] Person BusinessEntity (20.777)
[C1=] Person.BusinessErtityAddress (19.514)
[17=] Person BusinessEntityContact (303)
[C1=] Person Contact Type (20)

[1F=] Person CourtryRegion (238)
[ Person.EmailAddress (19.972)
[17=] Person Password (19.572)

(=] Person.Person {19,972}

[1F=] Person PersonPhone (13.572)
[C1=] Person.PhoneNumberType (3}
[1F=] Person StateProvince (181)

[ Production.BilCfMaterals (2,673)
[[17=] Production Cutture (8)

[ Production.Document (13}

[17] Production llustration (5)

Address|D

1
2
3
4
5
6
-
2
5
10
11
12
3
14
15
16
17
18
15
20
pal
22
23
24
25
26
<

Addressline1

1570 Napa Ct

5833 M. Dias Blv.
7484 Roundtree Drive
9539 Glenside Dr
1226 Shoe 5t

1399 Firestone Drive
5672 Hale Dr.

6387 Scenic Avenue
8713 Yosemite Ct
250 Race Court
1318 Lasalle Street
5415 San Gabriel Dr.
9265 La Paz

8157 W. Book

4912 La Vuelta

40 Eliis St.

6636 Anchor Drive
1873 Lion Circle
3148 Rose Strest
6872 Thomwood Dr.
5747 Shirey Drive
636 Vine Hill Way
6657 Sand Pointe Lane
80 Sunview Temace
5178 Jumping St.
5725 Glaze Drive

AddressLine2

NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL
NULL

City
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Bothell
Portland
Seattle
Duluth
Dallas
San Francisco

R I R R v R R R e = i e i R e e Q- e

Mo live servers connected.

Connect to a live server to enable
export of objects from source storage.

Completed

Selected: 1 object(s)

To start exporting process, select destination folder or create a new one and click OK.

Selected data will be saved into SQL script(s). To start the export select the
destination folder or create a new one and click OK. The export process will start
immediatehy.

| Documents

& Downloads
I [t Favorites

W Links

' Music
I | = Pictures

 Saved Games
I [ Searches

B Videos

Required time depends on how many objects are selected for export. By default, a progress window
appears after the export starts. The window shows the number of saved objects and rows (1). You can
disable the progress window directly in the window or go to the Options menu and select Show
progress dialog.
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The export can be cancelled by clicking an appropriate link in the progress dialog window (2) or by
clicking the Cancel export button on the taskbar (3).

File Options Help

5 Search in Person Address v
) 5

Browse | Destination
| =3 AdventureWorks2012_CS_Data mdf A BAdracelN  Addracel inal Addracelina? (e
@-[¥]C3 Programmability (4) Progress
=-[v]Ea Tables (71)
[V dbo. AWBLildVersion (1)
--[#][T] dbo.Databaselog (1.597) Exporting objects
[¥1[=] dbo.EmorLog (0)
-[¥][=] HumanResources.Department (16)
[=] HumanResources Employee (250)
[=] HumanResources.EmployeeDepartmer
[=] HumanResources.EmployeePayHistory
[=] HumanResources JobCandidate (13)
[=] HumanResources.Shift (3)
] Poron Aaoss (19519
[] Person.AddressType (6)
[=] Person.BusinessEntity (20,777)
-[¥][T7] Person.BusinessEntityAddress (19.614)
[¥][=] Person.BusinessEntityContact (309) .
--[#][T] Person ContactType (20) .
-[][T] Person.CountryRegion (238) 9
I Parson ot (957 Show thedaiog nextime | olse
[=] Person.Person (19,572) :
[T Person.PersonPhone (19,572) 20 6872 Thomwood Dr. Bothell
[=] Person.PhoneNumberType (3) :21 5747 Shirey Drive Bothell
[=] Person. StateProvince (121) 2 636 Vine Hil Way Portland
[ Production.Bil Of Materials (2,679) :23 6657 Sand Pointe Lane Seattle
.. [ Production Culture (8) ‘24 80 Sunview Temace Duluth
-[¥][=] Production.Document (13) 125 9178 Jumping St. Dallas
[¥1[=] Production. llustration (5) 5725 Glaze Drive San Francisco

@
o
>

No live servers connected.

Connect to a live server to enable
export of objects from source storage.

v

vVOREIdBddddddddddddddddIddEIR

| <
Exporting objects I 00:01:34 Selected: 95 object(s)

Tip

If you closed the progress window, it can be shown again by clicking on the progress bar on the status
panel.

Restoring exported scripts into SQL Server

SQL scripts exported from the offline database can be easily imported into live SQL Server manually

For this purpose a special bat-file, commit.bat, is generated while extracting data. It is stored in the
folder with restored scripts.

Usage for trust connection: commit.bat server name db name Usage for mistrust
connection:

commit.bat server_name db_name user_name password
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5 Granular Restore for Microsoft Exchange

5.1 Special features

Usage of Granular Restore for Microsoft Exchange and SQL can be more comfortable for a user due to
additional Options menu, which allows user to customize program work.

Detailed information about every option is described in this help section.
Note

PST encoding and Show deleted items options are not available for PST/OST files.

PST encoding

Exporting mail store data into PST allows to select a PST format that suits your version of Microsoft
Outlook. Outlook 2003, Outlook 2007, Outlook 2010 and Outlook 2013 process both Unicode and ANSI
PST files, but as for older versions of Outlook, they will not be able to open Unicode formatted PST files.
Previous versions of Outlook were using only ANSI format. The main reason for this change was to allow
for international character support and to extend the maximum size of PST files beyond the 2GB limit of
the ANSI formatted PST files.

In Granular Restore for Microsoft Exchange and SQL there are two ways to select suitable encoding for
output PST.

Output PST encoding can be changed while selecting a destination folder for restored PST files.

Selected data will be saved into pst file(s). To start the export select the destination
folder or create a new one and click QK. The export process will start immediatehy.

. Program Files &

. Prograrn Files (x36)

, Recovered_session
, Recovered_sessiond
, Recovered_sezsion3
, Recovered_sezsiond
, Recovered_sezsion3
, Recovered_sezsionb

[» totalemnd

PST encoding: [Unicode (Microsoft Outlook 2003, 2007, 2010 and 2013) 1

Unicode (Microsoft Outlook 2003, 2007, 2010 and 2013)
Make New Foldfa S| (Microsoft Outlook 2002 and earlier) )
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Alternatively, encoding for the output file can be changed in the Options menu at any time the program

runs. Selected value will be saved and used on the next program launch.

<

y Show progress dialog

Options | Help

Show notification panel

Search within attachments

Select mailboxes or folders to search

Incomplete messages 3

| PST encading 3 | Unicode (Microsoft Qutlook 2003, 2007, 2010 and 2013)
ANSI (Microsoft Outlock 2002 and earlier)

Show deleted items 3

Display time 3

alia
[ 59 HealthMailboxade 9ae e 5b54860a 10218267
Dﬁ HealthMailboxbaa 80422 26014532 528babb4e
ﬁ John
[ 59 Juliet Capulet
-1 59 Kyle Pakeman

(59 Lise

[ 59 Maria Woods
-] &9 Michzel
-[[] 49 Personal Archive - HealthMaiboxadeSae Febb
-[]9 Personal Archive - HealthMailboxbaaB42=260
-[]£9 Richard
[ 159 Robet Rise
ﬁ Fomeo Montague
-[]£59 Rudy Raid
-[]59 Susane Tler
Dﬁ SystemMailbox {ade9ae F-e5b5-4860-a1cf-021
-[]£9 Tim Goodler

C:\Exchange Server Database\Mailbox Database.edb

Size: 904 Mb
Date: 3/13/2014
Version: Exchange Server 2013

Transadtion logs not used.

22 mailboxes. Seledt a mailbox to display folders.

Load time: 00:00:03

File info

Completed

Incomplete messages

Incomplete messages, such as messages with missing properties, bodies, are hidden by default. This
option can be changed in the Options menu.
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Options | Help

Show notification panel

v Show progress dialog

Search within attachments

PST encoding

Select mailboxes or folders to search

Incomplete messages

Show deleted items

Display time

-y Ualia

-[]59 HeathMaiboxadeSee Febb54860a 1cf0218267
D@ HeatthMailboxbaa 80422 260149a2928ba 554
[1£9 John

-[]£39 Juliet Capulet

-[159 Kyle Pakeman

-5 Luise

-] 59 Mana Woods

-[]59 Michael

[[]£9 Personal Archive - HealthMailboxadsSae Febb!
-[[]£39 Personal Archive - HealthMailboxbaa 80422260
-] 59 Richard

-[]59 Robert Rise

-[]59 Romeo Mortague

-[]59 Rudy Raid

[1£9 Susane Tyler

-[159 SystemMailbox{adeSae A-¢5b5-4860-a 1cf-021¢
- 159 Tim Goodler

-0
Cl
[E
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[
[

< >
Completed

Note

After changing the way of displaying incomplete items, the database will be reopened.

Showing deleted items

Granular Restore for Microsoft Exchange and SQL provides an ability to process deleted items and

= 1ange Server Database\Mailbox Database.edb
Size: 904 Mb
Date: 3/13/2014
Version: Exchange Server 2013

Transadtion logs not used.

22 mailboxes. Select a mailbox to display folders.
Load time: 00:00:03

File info

folders. This special feature can be enabled via the Options menu. There are three available display

modes:

e non-deleted items - displays actual items in folders

e show only deleted items - displays items/folders deleted from a mailbox hierarchy, but not

physically

e show both deleted and non-deleted items - displays both actual items in folders and

items/folders deleted from a mailbox hierarchy.

Note that after selecting any way of processing deleted items, the database will be reopened.

Items, deleted from Exchange Server 2010 and 2013 databases, are stored in the folder Deletions and

have an appropriate type.
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File  Options Help

~

[ H & Search in Andrew Wait | yel |
V2 = ‘

Browse

=~} Maibox Data edb N Subject Fom | To Created X

Eg ,-’No;Nég:‘mEmal\fowEmdﬁnge Admiristrat b JESSICA | am somy thou Dalia Romeo Montague; Tim Goodler; Maria ... Thursday, August 16, 2012 3:00:17 A...

Dﬁ Andrew Wait A) ABHORSON Do you call Michael  Andrew Wait; Susane Tyler; Juliet Cap... Thursday, August 16, 2012 3:00:12 A...

[ Calendar (0)

[[]22] Contacts (D)

[ Deleted tems (0)
bl Deletions (2)

E
£
=

[JE@ Junk E-Mail (0)
[l Notes (0}
[C]E3 Outbox (0)
CJEa Sert kems (1)
[ Tasks ()
-] ﬁ Andy Kort

-[]&9 Brian

-1 Juliet Capulet
-9 Kyle Pakeman
-1 Luise

-9 Maria Woods
1759 Michael

-] Richard

-[_]£§ Robert Rise
-[]£9 Romeo Mortague
-[]79 Rudy Raid

£

Completed

As for items deleted from Exchange Server 2007 databases, they are stored in the their original folders
but can be easily recognized by an appropriate status.

Note

Items, stored in the folder Deletions, cannot be recovered to live Exchange Server database. It is
recommended to restore items from the Deletion folder to PST and then import to live Exchange Server.

Display time
There are two dates display formats available for users, local time and GMT.

To switch dates display format between local computer time and GMT, use the Options menu.
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Options | Help
Show notification panel

Show progress dialog {Search in Alex Clark

Search within attachments

PST encoding Type  {] Subject From To Created

Incomplete messages 0= She was glad that Jo should... Luise Maria Woods; Kyle Pakeman; Luise; .. Wednesday, March 12, 2014
Show deleted items ) 1= 9 In itsnature, it is arbitrary an...  Kyle Pakerman Andrew Wait; Richard; John; Dalia; Ro... Wednesday, March 12, 2014
Display time d Itis my lady mother. ttismy ... Juliet Capulet Romeo Montague; Richard; Dalia; Mic... Wednesday, March 12, 2014
Butthat it might not appeart... John Romeo Montague; Andy Kort; Robert ... Wednesday, March 12, 2014
Do you persuade yourseff th... Andy Kort Susane Tyler; Andy Kort; Juliet Capulet... Wednesday, March 12, 2014
| regret that | am unable tor... Brian John; Brian; Tim Goodler; Kyle Pakemn... Wednesday, March 12, 2014
Alas. the heavy basketwhic

ﬂ He went up a dark and narr... Rudy Raid Brian; Michael; Richard; Dalia; Luise; T... Wednesday, March 12, 2014
g

Noone, even there, could li... Romeo Montague  Brian; Alex Clark; Richard; Romeo Mon... Wednesday, March 12, 2014
One of the things particular... Robert Rise John; Maria Woods; Richard; Alex Clar... Wednesday, March 12, 2014
Stephen Brice read the new... Luise Alex Clark; John; Tim Goodler; Michael... Wednesday, March 12, 2014
Give me some light! Give m... Michael Romeo Montague: Richard; Andrew W... Wednesday, March 12, 2014
ﬁ His condition leaves him no ... Juliet Capulet Romeo Montague: Richard; Juliet Cap... Wednesday, March 12, 2014 v
>
. the heavy basketwhich the Colonel carried on his arm was X
v

ZADDDDDD
IZJ[Z&IEJI?JIEE

]D§ HealthMailboxade 9ae #e5b54860a1cf0218
o[ ]9 HealthMailboxbaa8042¢260149a2928ba55
0[] John . AlexClark § attachment(s):

[
[
[
[
[
[
[
&-( 159 et Capulet . Wednesday, March 12, 2014 20:28:00 UTC+03:00 [loRgit. 275 KB
w-[]59 Kyle Pakeman | | ESSAYS7ixt 222 KB
@] § Luise To: “Dalia” <Dalia@no-such-email.com>, "Kyle Pakerman” <Kyle.Pakerman@no... i

= . | " ) || ESSAYS-10.txt, 1.20 KB
-] 55 Maria Woods Cc: "Dalia” <Dalia@no-such-email.com>, "Kyle Pakerman” <Kyle.Pakerman@no... <
- (129 Mchael || ESSAYS-421xt, 561 bytes
<[] 59 Personal Archive - HealthMaiboxadeSae e s she did not It her voice at dinner, which was very poorindeed for || ESSAYS-46.¢t, 2.08 KB
-] 59 Personal Archive - HealthMailboxbaa8042e.  Colonel Carvel's house. All day long Virginia, assisted by Uncle Ben and u ESSAYS-48.txt, 2.31 KB
@] g Richard Aunt Easter, toiled in the stifling kitchen, preparing dainties which
E she had lona denied herself. At evenina she went to the station at __________________Kdihd
l Preview | Properties ‘

1-[]/53 Robert Rise

<
Completed

If you switch display time, a warning, that the file will be reloaded, appears.

Switching digplay time requires reloading the file. This may take a long time. Do you want to
continue?
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A message in GMT format looks the following way:

File Options Help

=& K

“ Browse ‘
=-[] ) Maibox Database.edb

<

| Search in Andy Kort
L

i[5 Alex Clark

[59 Andrew Wait
=-[159 Andy Kot
--[_]44] Calendar (439)
-.[] 8] Contacts (44)
- [C]3 Deleted tems (24)
--[]C3 Drafts (0)
B oo 1020 |
.. ] @l Joumal (27)
[ Junk Email (0)
[l Notes (40)
[ Outbox (0)
..[]C3 Sent kems (0)
[ & Tasks (47)
]D§ Brian
7] Dalia

[

[

[

[ —

[]...Dg John
(-] &9 Juliet Capulet
#1539 Kyle Pakeman
&[] 59 Luise
-[_] 9 Maria Woods
&[] &9 Michael

[

[

[

£

-] &9 Richard
-[]/59 Robett Rise

Completed

-] 59 HealthMailboxadeSae Fe5b54860a1cf0218
7-[_] =) HealthMailboxbaa804262601492a928ba55

-[_] 59 Personal Archive - HealthMailboxadeSae e
7-[_] =) Personal Archive - HealthMailboxbaa8042e:

>

A Type g Subject From To
[J& @ Inisnature, itis abitraryan... Kyle Pakerman
=] It is my lady mother. ktismy... Juliet Capulet
0= Butthat it might not appeart... John

[12 @ Doyoupersuadeyoursefft.. Andy Kort
0= It wasall eloquence, and ge... Tim Goodler
O=A 9 Alas, the heavy basketwhic... Alex Clark Dalia; Kyle Pakemman; Michael; Susan...
Noone, even there, could li... Romeo Montague  Brian; Alex Clark; Richard; Romeo Mon...
I:l d { Stephen Bricereadthene... Luise

(=] ﬂ Give me some light! Give m... Michael
0= It were good, therefore that ... Andy Kort
[J2 { Therderscouldbeheard).. Andrew Wait
0= Q The sinewand heart of man... Susane Tyler
<

Andrew Wait; Richard; John; Dalia; Ro...
Romeo Montague; Richard; Dalia; Mic...
Romeo Montague; Andy Kort; Robert ...
Susane Tyler; Andy Kort; Juliet Capulet...
Dalia; Tim Goodler; Robert Rise: Susa...

Alex Clark; John; Tim Goodler; Michael...
Romeo Montague; Richard; Andrew W...
Romeo Montague; Andrew Wait; Kyle ...
Susane Tyler; Maria Woods; Romeo M...

Brian; Juliet Capulet; Andy Kort; Robert...

-

Created

Wednesday, 12 Mar 2014 172
Wednesday, 12 Mar 2014 172
Wednesday, 12 Mar 2014 172
Wednesday, 12 Mar 2014 172
Wednesday, 12 Mar 2014 17
Wednesday, 12 Mar 2014 172

u He went up a dark and narr... | Rudy Raid Brian; Michael; Richard; Dalia; Luise; T... | Wednesday, 12 Mar 2014 17

Wednesday, 12 Mar 2014 17

Wednesday, 12 Mar 2014 172

Wednesday, 12 Mar 2014 17

Wednesday, 12 Mar 2014 17

Wednesday, 12 Mar 2014 172

Wednesday, 12 Mar 2014 17 v
>

X

He went up a dark and narrow stair into alighted hall with shrouded wind,

v

From: Rudy Raid

“Brian” <Brian@no-such-email.com>, "Michael” <Michael@no-such-email.com...

There came a rain-sodden night when a mysterious message amived at
the little house in Olive Street. Both arxiety and pride were in Mrs.
|Brice’s eyes as they followed her son out of the door. At Twelfth

|Street two men were lounging on the comers, each of whom glanced at
hlm Ilstessiy as he passed He went upa dark and namow stair |nto a

3 attachment(s):

|| ESSAYS-6.txt, 1.00 KB
|| ESSAYS-47 txt, 1.10KB
|| ESSAYS-48.ixt, 2.31 KB

‘ ‘ Prewew Properhas

Showing notification panel

Every program action is accompanied by an appropriate notification for user. Notification panel is
disabled by default, but can be easily enabled by checking Show notification panel in the Options menu.
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-

.
Show progress dialog Select mailboxes or folders to search

Search within attachments

P5T enceding

Incomplete messages » Mailbox Database.edb

Show deleted it 3

_m e_ s fems C:\Exchange Server Database\Mailbox Database.edb
BEplyins > Size: 904 Mb

Hg ﬁhm IovadeSae TeBo54860a 0210257 Do, 5/13/2014

| eal 3l eJae e - .

15 HealthMaiboxbaaD42s260145as028ba554e, ¥ 201> EXCT1ange Server 2013

Eg j::; Capulet Transaction logs not used.

' Kyle Pak
Eg L:d:e sreEman 22 mailboxes. Select a mailbox to display folders.

59 Maria Woods Load time: 00:00:02

]9 Michae!

Dﬁ Personal Archive - HeatthMailboxade9ae Febb

[]£J Personal Archive - HeatthMailboxbaa8042260

159 Richard

[]£J Robert Rise

]9 Romeo Montague

[J&) Rudy Raid

159 Susane Tyler

]9 SystemMailbox{zdeSae F-25b5-4860-a 1cf-021
[ ]9 Tim Goodler

< File info |

Completed

After that user will see additional information about opening file, export results, search results, etc.

File Options Help

= e Search in Andy Kort and 2
B H e |earc in Andy Kort and 2 more |p|

Erowse

Mailbox Database.edb

C:\Exchange Server Database\Maibox Database.edb
Size: 904 Mb

Date: 3/13/2014

Version: Exchange Server 2013

Dﬁ HealthMailboxade Sae e Sb54860a1cf0218267
(159 HeathMalboxbaz80422260149az928ba554e
Dﬁ John )

155 Julet Capuiet Transaction logs not used.
159 Kyle Pakeman

22 mailboxes. Select a maibox to display folders.
Load time: 00:00:04

1539 Michael
#-[_1£9 Personal Archive - HealthMailboxade $ae e 5o

[1£59 Romeo Montague

[¥]9 Rudy Raid

[ Susane Tyler

159 SystemMaibox{ade Sae -2 5b5-4860-a 1cf-021
(-[]&§ Tim Goodler

< >

" - X

12/9/2015 2:20:38 AM] Save time: 0 hour(s) 1 minute(s) 59 second(s) e

12/9/2015 2:20:38 AM] Exported 3 mailbox(es), 33 folder(s) and 4,872 message(s) into V\autotest-s\Recovered\CLIENT-PC\Recovery 001%,pst
12/9/2015 2:18:27 AM] Database load time: 0 hour(s) 0 minute(s) 4 second(s) W

File info

Completed Selected: 3 mailbox(es)
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5.2 Finding and selecting messages, folders and mailboxes

Granular Restore for Microsoft Exchange and SQL provides two mutually complementary modes of
finding, previewing and selecting items: browsing the mailbox tree and search. Using these, it is possible
to efficiently form a set of items for subsequent export, including the necessary ones and excluding ones
to be skipped.

A newly opened database is shown in the Browse mode.

Q) Granular Restore for Microsoft Exchange and SQL = B “
File  Options Help

":, Select mailboxes or folders to search p
Browse
=09

[£59 Mlex Clark Mailbox Database.edb

-9 Andrew Wait

&[] &5 Andy Kot C:\Exchange Server Database\Malbox Database.edb

]9 Bran Size: 904 Mb

e[ 15 Dalia Date: 3/13/2014

=-[ 159 HeathMailboxade 9ae Fe5b54860a 1cf0218267
-] HeathMailboxhaz 80422 26014%a528ba554e(
@[5 John

[[&9 Juliet Capulet

Kyle Pak
E: L:::e sreman 22 mailboxes. Select a maibox to display folders.

[]&9 Maria Woods Load time: 00:00:04
@[] &5 Michsel

[1&9 Personal Archive - HealthMailboxadsSae Febb!

[ 159 Personal Archive - HealthMailbaxbaa80422 260

Version: Exchange Server 2013

Transaction logs not used.

[] 59 Romeo Montague

[]&9 Rudy Raid

[[] &9 Susane Tyler

[]&9 SystemMailbox{ade9ae 7-2505-4860-a1cf-021
-9 Tim Goodler

< 5| Fileinfo

Completed

Browsing mail store tree

Browse mode shows mail store in a tree-like structure and allows browsing folders and previewing
individual items.

This mode is best for navigating to specific mailboxes, folders and messages when it is precisely known
what data needs to be extracted.

For example, a user may ask to restore a specific message from a known folder. Expand his or her
mailbox in the tree, select the folder, find and click the item. All available properties and information
about the item will be displayed in the Preview window to the right of the tree.
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File Options Help

B uh_‘ s |Searchin Andy Kot ‘P‘

| Browse |
2-[]43 Maibox Database edb Tyee (] Subject From To Created

O= g In itsnature, it is arbitrary an... Kyle Pakeman Andrew Wait; Richard; John; Dalia; Ro... Wednesday, March 12, 2014
=] It is my lady mother. kismy... Juliet Capulet Romeo Montague; Richard; Dalia; Mic... Wednesday, March 12, 2014

[ 121 Calendar (433) O vﬂ Butthat it might not appeart... John Romeo Montague; Andy Kort; Robert ... Wednesday, March 12, 2014
.[] 52 Contacts (44) O= Q Do you persuade yourselft... Andy Kort Susane Tyler; Andy Kort; Juliet Capulet... Wednesday, March 12, 2014
..[]C Deleted tems (24) 0= It wasall eloquence, and ge... Tim Goodler Dalia; Tim Goodler; Robert Rise; Susa... Wednesday, March 12, 2014
-CEa Draﬁs (V) O=A 9 Alas, the heavy basketwhic... Alex Clark Dalia; Kyle Pakerman; Michael; Susan... Wednesday, March 12, 2014
B[] inbox (1.024) | -
] _' Joumal |, 2‘) Noone, even there, could li... Romeo Montague Bnan Alex Clark Rlchard Romeo Mon Wednuday March 12 2014

- [JC@ Junk Email (0) I:l u_i 9 Stephen Brice read the ne...  Luise Alex Clark; John; Tim Goodler; Michael... Wednesday, March 12, 2014
[y Notes {40) (=] ﬂ Give me some light! Give m... Michael Romeo Montague; Richard; Andrew W... Wednesday, March 12, 2014
-[_]Z3 Outbox (0) 0= It were good, therefore that ... Andy Kort Romeo Montague; Andrew Wait; Kyle ... Wednesday, March 12, 2014
- []C3 Sent kems (0) [0 (] Theriderscouldbeheard).. Andrew Wait Susane Tyler; Maria Woods; Romeo M... Wednesday, March 12, 2014
Dg g Tasks (47) [1 { Thesnewand heart of man... Susane Tyler Brian; Juliet Capulet; Andy Kort; Robert... Wednesday, March 12, 2014 " v
- ian
- Dalia -

]Sg HealthMaibboxadeSae Ae8b54860a1cf0218 | ¢ WeNt up @ dark and

]|j§ HealthMailboxbaa8042e260149aa928b355

0[] John From: Rudy Raid 3 attachment(s):

£
£
£
£
[ S
- 159 Julet Capuiet Sent  Wednesday, March 12, 2014 10:29:00 AM UTC-07:00 B ESSAYS G (0KE
@[] &3 Kyle Pakeman 55 : . SRR A : | ) ESSAYS-47.4¢t, 1.10KB
& 9 Luise To: Brian” <Brian@no-such-email.com?, "Michael” <Michael@no-such-email.com... v

f . || ESSAYS-48.txt, 2.31 KB
£
£
£
£
[

-

-] 5 Maria Woods
]D@ Michael There came a rain-sodden night when a mysterious message amived at

q-[] g Personal Archive - HealthMailboxade9ae Fe e little house in Olive Street. Both anxiety and pride were in Mrs.
Brice’s eyes as they followed her son out of the door. At Twelfth

-] =9 Personal Archive - HealthMaiboxbaag42e: Street two men were lounging on the comers, each of whom glanced at

]E]§ Richard him listessly as he passed. He went up a dark and namow stair into a
o[ ]/ Robert Rise . rala Be il bzt ks fdl
< P Properti

Completed

There is a check box next to the message. Check it to mark the message for export. Continue to mark
other items, folders and mailboxes for export in a similar way.
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File Options Help

V.j H Q.’—.. iSearchmAndyKon ‘P'

“ Browse ‘
=-[#] () Maibox Database.edb Type ) Subject From To Created
=] g In itsnature, it is arbitrary an... Kyle Pakeman Andrew Wait; Richard; John; Dalia; Ro... Wednesday, March 12, 2014
=] It is my lady mother. kismy... Juliet Capulet Romeo Montague; Richard; Dalia; Mic... Wednesday, March 12, 2014
[ 121 Calendar (433) 2= Butthat it might not appeart... John Romeo Montague; Andy Kort; Robert ... Wednesday, March 12, 2014
.[] 52 Contacts (44) (=] Do you persuade yourselft... Andy Kort Susane Tyler; Andy Kort; Juliet Capulet... Wednesday, March 12, 2014

[ Deleted tems (24) |7 = | wasall eloquence, and ge... Dalia; Tim Goodler; Robest Rise; Susa... |Wednesday, March 12, 2014

-

He went up a dark and narr... Rudy Raid Brian; Michael; Richard; Dalia; Luise; T... Wednesday, March 12, 2014
Noone, even there, could li... Romeo Montague  Brian; Alex Clark; Richard; Romeo Mon... Wednesday, March 12, 2014
Stephen Brice read the ne...  Luise Alex Clark; John; Tim Goodler; Michael... Wednesday, March 12, 2014
Give me some light! Give m... Michael Romeo Montague; Richard; Andrew W... Wednesday, March 12, 2014
It were good, therefore that ... Andy Kort Romeo Montague; Andrew Wait; Kyle ... Wednesday, March 12, 2014~
The riders could be heard|... Andrew Wait Susane Tyler; Maria Woods; Romeo M... Wednesday, March 12, 2014
The sinewand heart of man... Susane Tyler Brian; Juliet Capulet; Andy Kort; Robert... Wednesday, March 12, 2014 " v

>
1-[]59 Dalia e
]Sg HoothMolboxadeSee o8 548608 160218 a andg o S i X
]D§ HealthMailboxbaa8042e2601493a928ba55 Y
0[] John From: Tim Goodler
7-[_] 59 Juliet Capulet

£
£
£
£
£
E]D@ Kyle Pakerman Sent  Wednesday, March 12, 2014 10:28:00 AM UTC-07:00
£
£
£
£
£
£
£

G o (1,024
[ ] 8l Joumal ( 2')
-]z Junk Email (0)
.[Jw_ Notes (40)
.. Outbox (0)
-[]c3 Sent tems (0)
[/ Tasks (47)
]D@ Brian

!D!D

4
Lt
-[JEa@ Drafts (0) = 9 Alas, the heavy basketwhic... Alex Clark Dalia; Kyle Pakemman; Michael; Susan... Wednesday, March 12, 2014 "
0
g
g
g
0

EEEEEEE

s A JROR

g-[] § Luise To: “Dalia” <Dalia@no-such-email.com>, “Tim Goodler” <Tim.Goodler@no-such-email.com>, "Robert Rise...
]D§ Maria Woods Cc: "Dalia” <Dalia@no-such-email.com>, "Tim Goedler” <Tim.Goodler@no-such-email.com>, "Robert Rise...
-] ) Michael
]E]§ Personal Archive - HealthMailboxadeSae e The Cure frowned and continued: "You look on yonder buming walls,' he
-[_] =) Personal Archive - HealthMailboxbaa8042e: said, ‘'and wonder when they will rise again on this hill made sacred

q-[] g Richard bythe burial of your beloved, by the christening of your children, the
o[]S Robert Rise which have given vou hapov homes. and the sac

< ‘ Preview LProperha ‘

Completed Selected: 1,019 item(s) in 1 mailbox(es}

Use filtering feature for better browsing the list of items in a folder.

Enable filtering by pressing Ctrl+F keys. A special panel will appear in the right part of the program
window.
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File

Options  Help

Browse i
| &-[] 3 Maibox Database.edb

<

[E

[E

E

[

[

[

E ~
w59 Luise
[

[

[

[E

E

[

-] Alex Clark
7-[] 59 Andrew Wait

5[] 59 Andy Kort

-[_|i] Calendar (439)

~[] &« Contacts (‘4‘;

-[_|[C3 Deleted tems (24)

.[]3 Drafts ()

- Clca A

[ ] & Joumal (27)

-[_]Z@ Junk Email (0)

] Notes (40)

-[_][Z@ Outbox (0)

-] Sent ttems (0)

-] Tasks (47)

]Dg Brian

-[ ]9 Dalia

-[ ]9 HealthMailboxadeae Fe5b54860a1cf0218
7-[] 59 HealthMailboxbaa8042¢260149aa928ba55
i-[ ]9 John

j|:|§ Juliet Capulet

-] 59 Kyle Pakerman

-] =9 Maria Woods

-] 9 Michael

-[_] =9 Personal Archive - HealthMailboxadeSae e
-] 59 Personal Archive - HealthMailboxbaa8042e:
£]-- Dg Richard

-] 5§ Robert Rise

Completed

Tip

| Search in Andy Kort

: Type g Subject From To Created
O= g Privatebankers in London gi... Tim Goodler Romeo Montague; Alex Clark; Susane ... Wednesday, March 12, 2014 10;
| ] .J Schools have no exclusivep... Juliet Capulet Rudy Raid; Dalia; Romeo Montague; ... Wednesday, March 12, 2014 10

[M = | |Thisrelactionintheexciusi [Dalia | Maria Woods: Susane Tyler: Andy Kan Wednesday, March 12, 2014 104

I || [ Select fitered tems
This relaxation in theexclusive privileges of the company. is probably the principal...
v

From: Dalia

Sent  Wednesday, March 12, 2014 10:21:00 AM UTC-07:00

To: “Maria Woods™ <Maria. Woods@no-such-email.com>, "Susane Tyler” <Susane.Tyler@no-such-email.com...
The Dutch settlements in the West, as well as those in the East Indies,
were originally put under the govemment of an exclusive company. The

progress of some of them, therefore, though it has been considerable in
\comparison with that of almost any country that has been long peopled

and established, has been languid and slow in comparison with that of
i . e = oo ey

Preview | Properties

Each individual item, folder and mailbox has a check box next to it. Using these check boxes, it is possible
to select as many or as few items for export as necessary.

To export an entire:

e mail store, mark the root check box with the mail store name.

e mailbox, mark the check box next to mailbox in the tree.

o folder, expand a mailbox and mark the check box next to the desired folder.

Using search

The search in the main window provides the ability to search single or multiple mailboxes and perform

actions on the search results.

The best application of search mode is when the location and/or number of items to extract is not

known exactly. Using keyword search, it is possible to narrow down on specific messages, folders and

mailboxes. The quickest way to get search results is clicking on a particular mailbox, entering some
keywords in the Search field and clicking the button Start search.
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Search results will be displayed on a separate tab.

File  Options Help

|Seart:h in all mailboxes: wait | p |

g
o

Location g Subject From To Crea ™

“Alex Clard\Calendar Lysander! Brian John; Kyle Pakerman; Tim Goodler; Ro... Wed
“Alex ClarkCalendar Break off thy Dalia Alex Clark; Rudy Raid; Luise; Tim Goo...  Wed
“Alex Clard\Calendar How frequenthy Richard Maria Woods; Michael; Robert Rise; R... Wed
“Alex Clard\Calendar She was going Rudy Raid John; Susane Tyler; Luise; Romeo Mo... Wed
“Alex Clark\Calendar It Robert Rise John; Rudy Raid; Alex Clark; Michael; ... Wed
“Alex Clard\Calendar Mow, Michael Luise; Brian; Rudy Raid; Andy Kort; An... Wed
“Mex ClankCalendar Kyle Pakeman Alex Clark; Rudy Raid; Maria Woods; ... Wed
“Alex Clard\Calendar Suit the action Tim Goodler Kyle Pakeman; Susane Tyler; Rudy R... Wed
“Alex ClankCalendar Luise Juliet Capulet; Brian Wed
“Alex Clark\Calendar So Andrew Wait Brian; Luise; Tim Goodler; Alex Clark; K... Wed
“Mex ClarkCalendar Romeo Montague  Andrew Wait; Juliet Capulet; Andy Kort... Wed
“Alex Clark\Calendar What false ltalian- Robert Rise John; Andrew Wait; Michael; Richard; ... Wed
“Alex Clark\Calendar She hadheard Susane Tyler Tim Goodler; John; Andy Kort; Juliet Ca... Wed
“Alex Clard\Calendar VARRO. VARRO. Romeo Mortague  Richard; Juliet Capulet; Tim Goodler; Al... Wed
“Alex ClaraCalendar The emaluments of Alex Clark Juliet Capulet; Brian; Romeo Mortague... Wed
“Alex Clard\Calendar Atradesmanwho had Kyle Pakeman Juliet Capulet; Susane Tyler; Richard; ... Wed
“Alex Clara\Calendar ROSS. Romeo Montague  Andrew Wait; Robert Rise; Richard; Bri... Wed
“Alex ClarkCalendar Onthe Andy Kort Alex Clark; Rudy Raid; Maria Woods; ... Wed
“Alex Clard\Calendar Part of them linen Michael Andrew Wait; Juliet Capulet; Romeo M... Wed
“WAlex Clark\Calendar Maria Woods Alex Clark; Andrew Wait; Luise: Robert... Wed
“Alex Clard\Calendar Luige Susane Tyler; Michael; Kyle Pakeman... Wed
“Alex Clark\Calendar Indeed there can John Juliet Capulet; Dalia; Alex Clark Wed
“Alex ClarkCalendar So came his Brian Richard; Michael; Susane Tyler; Alex C... Wed
“Mex ClankCalendar Where is Andrew Wait Richard: John: Alex Clark; Rudy Raid: ... Wed .,
>

I 4 |Page 1 of10| oM 0 messagesperpage

[[]22] Contacts (1)
[]E Deleted tems (16)
[ Inbax (625)
] Tasks (1)

Al O000O0O00O00O000O0O0O0O00ooooOooOonO
£ LEE L L I L L I (R L I L R I

Search complete, 977 matches

If a user knows exactly in what mailbox or folder the data is located, using Search in mailbox option will
speed up the search.

Right-click on a folder/a mailbox will open a context menu.
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File  Options Help

~u
= H o Select maiboxes or folders to search
=

Browse

=-[]ug Mailbox Database edb
-] Alex Clark Mailbox Database.edb
Dﬁ Andrew Wait
-0 Andy Kort C:\Exchange Server Database\Maibox Database.edb
-[J£9 Brian Size: 904 Mb

Eg gahTthM iboxade9ae Ae5b54860a1cf 0218267 Date: 3/13/2014
eal all eJae e o -
-[[]£9 HealthMaiboxbaa8042e260149a39280a554e( Version: Exchange Server 2013

Search in mailbox Transaction logs not used.

Collapse all mailboxes 22 mailboxes. Select a mailbox to display folders.
Clear all selections Load time: 00:00:04

-1 M
Dﬁ Personal Archive - HeathMailboxade3ae Febb
-[_]£9 Personal Archive - HeathMailboxbaz 80426260
-[_1£9 Richard

-[]£9 Robert Rise

Dﬁ Romeo Montague

-[]&9 Rudy Raid

Dﬁ Susane Tyler

-5 SystemMailbox{ade Sae F-e5b5-4860-a 1cf-021
-[1£59 Tim Goodler

< File info |

Completed

By clicking on this menu advanced mode of search dialog will be opened and Search in field will be filled
with the selected mailbox/folder.

Fill in necessary search parameters and start the search.
For more precise searches click on the Search field, drop-down list of all search fields will appear:

e Search in - specifies mailbox(es)\folder(s) to search in. Default: entire database. If you select
one or more Search in check boxes, but specify no additional search criteria, the utility will
return all items from the selected folder(s).
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Search in... “

=RCINY] A
-[_] =5 Alex Clark
i[9 Andrew Watt
5[50 Andy Kor
—-[®] 5 Brian
-] Calendar (

-] ] Contacts
-] Deleted tems (228
-] Drafts {0)
- [WIET Inbax

.4 Joumal 2
-[CJE3 Junk Emai
~[Ju MNotes (40
- |E3 Outbox ()

[CEa Sent tems (D)
12 Tasks 47)
+-[_]) Dalia
#-[ ] £5 HealthMailboxadeSae Febb54860a1cf021826768730
jljﬂ HealthMailboxbaaBl42e260149aa928ba5542009d7d 3
i[5 John
i[5 Juliet Capulet
i-[] £ Kyle Pakeman
o[ Luise
H-[_] =9 Maria Woods
i-[ |5 Michael
#1258 Personal Archive - HealthMailboxade9ae e 5b 548602 1cf021826 768730 he

[7] Include mailboxes that are expanded, have tems sslected or were searched before

e Has words - search for mail store items that have words or phrases entered in the field.
e Doesn't have - search for items that do not have words or phrases entered in the field.
e Has attachments - search for items with attachments.

e From - search for keywords in the From: field.

e To - search for keywords in the To: field.

e Subject - search for keywords in subject.

e Date range - set specific date range if known. It is obligatory to set both the beginning and
the end of the desired time period.

The outcomes of a search can be:

1. The program was able to find items (1) that corresponds to specified search parameters (2). The user
can select separate items or mark search results for recovery.

Clicking an item in the search results tab will open the item preview. Selecting item(s) in search results
will make their recovery possible.
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File  Options Help

£ Andrew Wait (43)
] Calendar (25)
[ Inbex (12)
5 Andy Kort (19)
[ ]E Inbax (19)
Qljﬁ Brian (14)
L[ e Inbox (14)

g—eart:h in all mailboxes: from:{Andrew) hasattachment wait | p

Location
“WAndy KortInbox

Searchin... | |Entire database

“WAlex ClarkInbox

“BrianInbox

Include mailboxes that are expanded, have items selected or were
“WAndrew Wait'Inbox searched before

\Andy Kort\Inbax Has words: |me:¢»‘\ndrew} hasattachment wait

“Andy Kort\Inbox Doesnt have: |

“WAndrew Wait'Inbox

\Alex Clark'\Inbox [[] Has attachments

SAndrew Waitnbox From: |

“WAlex ClarkInbox

\Brian\Inbex Te:

e Clarknbox

|
\Alex Clark\Inbox Subject: |
|

“Andy Kort\Inbax Date range:

“\Andy Kort\Inbox
“WAndrew Wait'Inbox
“Alex Clarnbox 1l drop the paper-
“WAndrew Wait'Inbox
“WAndy KortInbox

“Andy Kot nbox Alone she was in thehouse—her brother....
“WAndrew Wait'Inbox Alone she was in thehouse—her brother...
“WAndrew Wait'Inbox Dan still owns it. Dan still owns it. Dan ..
“WAlex ClarkInbox Dan still owns it. Dan still owns it. Dan ...
“BrianInbox Dan still owns it. Dan still owns it. Dan ..

;Hd <J|Page1of1|w M U

Andrew Wait

Andrew Wait
Andrew Wait
Andrew Wait
Andrew Wait
Andrew Wait
Andrew Wait

it ert Rise; id; Jul
Andy Kort; Romeo Montague; Michael;
Andy Kort; Romeo Montague; Michael;
Kyle Pakerman; John; Susane Tyler; Ri
Kyle Pakerman; John; Susane Tyler; Ri
Robert Rise; John; Kyle Pakerman; Mi.
Robert Rise; John; Kyle Pakerman; Mi.
Robert Rise: John: Kyle Pakeman: Mi..
>

Search complete, 96 matches

100 | messages per page

Counters of found elements are automatically updated or can be updated manually by clicking on the
Refresh button. If any folder is selected and the program has found new elements in it, then the

following value will be shown: previous(value, when we selected the folder) value of a counter +

count(in green) of newly found elements, which will be updated in real-time.
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File  Options Help

b = . q & |Seart:h in all mailboxes: wait

Browse | Search: "wait” (4,311

£ Alex Clarke (5777
[y Calendar (274)

—

Location g Subject From To

“WAlex Clark'\Deleted tems THERSITES. Alex Clark Andy Kort; Juliet Capulet; Michael; Rab...
“Mlex Clark\Deleted tems The emoluments of Alex Clark Juliet Capulet; Brian; Romeo Montague...
“Alex Clarknbox Part of them linen Michael Andrew Wait; Juliet Capulet; Romeo M.
“WAlex ClarkInbox Maria Woods Alex Clark; Andrew Wait; Luise; Robert...
e Clarknbox Luise Susane Tyler; Michael; Kyle Pakeman...
“Alex Clarknbox Indeed there can John Juliet Capulet; Dalia; John; Alex Clark
“Alex Clark\nbox So came his Brian Brian; Richard; Michael; Susane Tyler; ..
“WAlex ClarkInbox Where is Andrew Wait Richard; John; Andrew Wait; Alex Clar...
“Alex ClarkInbox Tis Richard Romeo Montague; Brian; John; Tim Go
“Alex Clarknbox The average John Robert Rise; Luise; John; Susane Tyler...
“Alex ClarkInbox VIRGILIA. VIRGILIA. Andrew Wait Kyle Pakemman; Brian; Michael; Andre...
“Alex ClarkDeleted tems Of poets perhaps Alex Clark Brian; Richard; Michael; Susane Tyler; ...
e Clarknbox Robert Rise Robert Rise; Alex Clark; Dalia; Andrew ...
“Alex Clarknbox Amongst a man's Rudy Raid Robert Rise; Luise; Kyle Pakeman; Jul...
“Alex Clarnbox Tim Goodler Susane Tyler; Andy Kort; Juliet Capulet...
“Alex Clarknbox On this we Luise Richard; Romeo Montague; Juliet Cap...
“Alex Clarnbox The people of Maria Woods Brian; Juliet Capulet; Luise; Kyle Paker...
“Alex Clarknbox "| am thirsty Andrew Wait Romeo Montague; Kyle Pakeman; Juli...
“Alex ClarkDeleted tems Time, Alex Clark Andy Kort; Juliet Capulet; Michael; Rob...
“Alex ClarkInbox Where's John Robert Rise; Rudy Raid; Alex Clark; An...
“Alex Clarknbox Stay yet another Dalia Susane Tyler; Tim Goodler; Kyle Paker...
e Clarknbox Good repose the Andrew Wait Robert Rise; Luise; Kyle Pakeman; Jul...
“Alex Clarknbox It is certainty Rudy Raid Juliet Capulet; Tim Goodler; Michael; B...
“Alex ClankInbox Froude and others, Andy Kort Michael: Romeo Montague: Andrew W

[ Deleted tems (25)

[l Inbox (1.008)

.48 Joumal (2)

[l Notes (2}

[ Tasks )

2-[1/5 Andy Kort (343)

[ ]2 Calendar (276)

[ Deleted tems (16)

[]Ea Inbox (645)

.8l Joumal (2)

[N Motes (3)

2-[1/5 Brisn (330)

[ ]2 Calendar (272)

[ &) Cortacts (3)

[ Deleted tems (14)
3 Inbon (547

[ Tasks (1)

HHHHEEEEHEEEEHEE HHEE EEEE
EESES=E=SS=S2=S=S=S2S S5 5 S S5 S = =5 = == = =

<

Al O000O0O00O00O000O0O0O0O00ooooOooOonO

>

(L |Page Tofd [ b MM O masagsperpage

Search complete, 4,311 matches

Words and phrases which match the search query are highlighted in the preview, which helps to easily
identify where the match was found.
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File

& &

Browse | Search: "from:(&ndrew \wait) wait”™ (108) X|

Options  Help

(-._u}

|Seart:h in all mailboxes: from:{Andrew Wait) wait

Location

“WAndrew Wait'Inbox
“WAndrew Wait'Inbox
“WAndrew Wait'Inbox
“WAndrew Wait'Inbox
“WAndrew Wait'Inbox
“WAndrew Wait'Inbox
“WAndrew Wait'Inbox
“WAndrew Wait'Inbox
[ B “Andrew Wait\Inbox
(W = |\Andrew Wait\Inbax
[ B “Andrew Wait\Inbox
[0 B “Andrew Wait\Inbax
<

Subject
11l drop the paper-

0
0
0
g
0

SHALLOW. SHALLOW. SHALLO..

Thesubscribers to a new loan, who me...

Let it be vituous to be obstinate. Let it
- Hisgarments hung in tatters; his boats

Sweet leaves, sha...
They were getting kind of interested. T...

Alone she was in thehouse-her brother..
In this action it isgenius; not the privileg..

And in the ages to come, women such ..

ﬁ [Aside to MENAS] | think th'art mad. [A...

From

Andrew Wait
Andrew Wait
Andrew Wait
Andrew Wait
Andrew Wait
Andrew Wait
Andrew Wait
Andrew Wait
Andrew Wait
Andrew Wait
Andrew Wait

To

Andy Kort; Robert Rise; Rudy Raic
Rudy Raid; Andrew Wait; Romeo
Andy Kort; Romeo Montague; Micl
Kyle Pakerman; John; Susane Tyl
John; Kyle Pakerman; Romeo Mor
Alex Clarke; Juliet Capulet; Luise; R
Robert Rise; Maria Woods: Luise;
John; Michael; Luise; Susane Tyle
Alex Clarke; Andrew Wait; Luise; R
Kyle Pakerman; Maria Woods; Anj
Andrew Wait; Luise; Kyle Pakemz
John; Kyle Pakerman; Andrew Wa

his boots were i d and sol

Hisgarments hung in

HH
v

"Kyle Pakerman” <Kyle Pakerman@no-such-email.com?, "Maria Woods™ <Maria. Woods@no-such-email.com...

"Kyle Pakerman” <Kyle.Pakerman@&@nc-such-email.comz, "Maria Weods”™ <Maria. Woods@no-such-email.com...

The toil and privation had wom him down and he was like iron. His

=i = flow
Preview

L] 4|Page1of2|P [ S

gaments hung in tatters; his boots were ripped and soleless. Long

Search complete, 109 matches

IMESSAgES PEr page

2. The search didn't match any items. Review search parameters and run another search.

To delete temporary data, generated by Granular Restore for Microsoft Exchange and SQL, go to the
File menu and click Delete saved search indexes and logs.
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File | Options Help

Open file... Ctrl+0
Recent v Search in all mailboxes: wait p
Close file
Reload database using transaction logs
] Location { Subject From To (g &
Search for files to open...
Sl Alex Clark\Deleted tems THERSITES. Alex Clark Andy Kort; Juliet Capulet; Michael; Rob... W
Export selected items into PST... Ctrl+5 1 \Alex Clark\Inbox Brian Alex Clark: Tim Goodler: John: Romeo ... Wi
Export into ariginal Exchange mailbox...  Ctrl+G 1 \Alex Clark\Inbox The maintenance of Andrew Wait Kyle Pakerman W
i 1 \Alex Clark\Inbox Chaudiere had Susane Tyler Andrew Watt; Andy Kort; Alex Clarde; M... W
Cancel current operation G B \Alex Clarknbox Beside Robert Rise Richard: Andy Kort; Maria Woods: Sus.. '\
Open log folder 1 \Alex Clark\Inbox Breal: off thy Dalia AMlex Clark; Rudy Raid; Luise; Tim Goo... W
“Alex ClarkInbox How frequenthy Richard Maria Woods; Michael; Robert Rise; R... W
ESEsatell SIS andliog “Alex Clarknbox She was going Fudy Raid John; Susane Tyler; Luise; Romeo Mo... W
Alt+X “Alex Clark\Inbox Now, Michael Luise; Brian; Michae!; Rudy Raid: Andy... W
e WAlex Clarknbox Kyle Pakeman AMlex Clark; Rudy Raid; Maria Woods; ... W
[ B \Alex Clark\Inbox Suit the action Tim Goodler Kyle Pakeman; Susane Tyler; Rudy R.. W
[ B \Alex Clark\Inbox Luise Juliet Capulet; Brian W
C159 Andy Kort (343) [ El \Alex Clark\Inbox So Andrew Wait Brian; Luise; Tim Goodler; Alex Clark; K... W
~[] 4 Calendar (276) [ EH \Alex Clark\Inbox Romeo Mortague  Romeo Montague; Andrew Wait; Juliet... W
-] Deleted ttems (16) [ 8l \Alex ClarkInbos Wht false halian- Robert Rise John; Andrew Wait; Michasl: Richard: . W\
[ B \Alex Clark\Deleted tems The emoluments of Alex Clark Juliet Capulet; Brian; Romeo Montague... W
[ 5 “Alex ClarkInbax Atradesmanwho had Kyle Pakeman Juliet Capulet; Susane Tyler; Richard; ... W
[ B \Alex Clark\Inbox ROSS. Romeo Montague  Andrew Wait: Robert Rise; Richard: Bri... W
[ B8 \Mlex Clark\Inbox Part of them linen Michael Andrew Wait: Juliet Capulet: Romeo M... W
[ B \Alex Clark\Inbox Maria Woods Aex Clark; Andrew Wait; Luise; Robett... W
[ B \Alex Clark\Inbox Indeed there can John Juliet Capulet: Dalia: John: Alzx Clark W
..... [CJE3 Inbox (540) [T B “Alex Clark\Inbex So came his Brian Brian; Richard; Michael; Susane Tyler, ... Wi
..... 14 Tasks (1) [J B Alex Clarkc\Irbox Where is Andrew Wait Richard; John; Andrew Wat; Alex Clar... '
[ B8 \Mex Clark\Inbax Tis Richard Romeo Montague; Bran; John; Tim Go... W o,
< >

"4 |Page1 ofd*| b b O me;sagesperpage

Search complete, 4,311 matches

Note

Next search in the same folder/mailbox will be almost instant (only if saved search indexes and logs
haven't just beendeleted).

Note

Search with empty query is not available.

Note

Asterisk ('*') is added to all words in search fields by default. This allows to find not only specified words

but also their word forms. Use quotes (" ") to search for an exact phrase.
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Advanced search

Advanced search uses symbols and operators in queries. These operators allow you to find what you're
looking for quickly and accurately.

To use advanced search enter operators and their values into the Search field (1).

File  Options Help

~
I/ =7 H o E:eled mailboxes or folders to search: from:"alex” subject:"follow™
1 5

EBrowse

[ERMIY ] Mailbox Database edb

B8 Mailbox Database.edb
-[]59 Andrew Wait
-[JE£9 Andy Kort C:\Exchange Server Database\Maibox Database.edb
-9 Brian Size: 904 Mb

-] Dala Date: 3/13/2014

-[[]£9 HealthMaiboxadeSae Ae5b54860a 1cf0218267 e
-[[]£§ HealthMaiboxbaaB042:26014%aa328ha554e( version: Exchange Server 2013

John .
Eg Julit Capulet Transaction logs not used.

Kyle Pak
Eg L:::e FrEman 22 mailboxes. Select a mailbox to display folders.

-[]&9 Maria Woods Load time: 00:00:04
-] Michael

Dﬁ Personal Archive - HealthMailboxadeSae Febb
Dﬁ Personal Archive - HealthMailboxbaz 8042260
-[]&9 Richard

Dﬁ Fobert Rise

-[]£9 Romeo Mortague

-] Rudy Raid

-[]£9 Susane Tyler

Dﬁ SystemMailbox {ade 3ae #-25b5-4860-a1cf-021
-[]&9 Tim Goodler

< File info

Completed

Operators are listed below:

Operator Definition Example

from: Used to specify the sender. Example: from:alex
Meaning: messages from Alex.

to: Used to specify a recipient. Example: to:John
Meaning: all messages that were sent to
John (by any user).

subject: Search for words in the subject line. Example: subject:dinner
Meaning: messages that have the word
"dinner" in the subject.

OR Search for messages matching term |[Example: from:alex OR from:john
A or term B. Meaning: messages from Alex or from
OR must be in all caps John.
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Operator Definition Example

AND or Space Search for messages matching term Example: from:alex AND from:john
A and term B. Meaning: messages from Alex and from
AND must be in all caps. John.

- Used to exclude messages from Example: dinner -movie

(hyphen) your search. Meaning: messages that contain the word

"dinner" but do not contain the word
"movie".

has:attachment

Search for messages with an
attachment.

Example: from:john has:attachment
Meaning: messages from John that have
an attachment.

*capitalization isn't taken into
consideration.

att_name: Search for messages with specified Example: to:jane att_name:photo.png
attachment name. Meaning: messages to Jane that have an
attachment with specified attachment
name.
cc: Used to specify recipients in the Example: cc:John
bcc: cc: or bec: fields Meaning: messages that were cc-ed to
Search on bcc: cannot retrieve John.
messages on which you were blind
carbon copied.
" Used to search for an exact Example: "i'm feeling lucky"
(quotes) phrase* Meaning: messages containing the phrase

m feeling lucky" or "I'm feeling lucky".

Example: subject:"dinner and a movie"
Meaning: messages containing the phrase
"dinner and a movie" in the subject.

()

Used to group words
Used to specify terms that
shouldn't be excluded.

Example: from:alex (dinner OR movie)
Meaning: messages from Alex that
contain either the word "dinner" or the
word "movie".

Example: subject:(dinner movie)

Meaning: messages in which the subject
contains both the word "dinner" and the
word "movie".

create_time:[yyyymmdd
yyyymmdd]

Search for messages created
during a certain period of time.

Example: create_time:[20110416
20110516]

Meaning: messages created between
April 16, 2011 and May 16, 2011.
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Operator Definition Example

after: before: Search for messages sent or Example: after:20110416
received during a certain period of |before:20110516

older: newer: time Meaning: messages sent between April
{l(using the date format yyyymmdd).}|16, 2011 and May 16, 2011.

More precisely: messages sent after 12:00
M (or 00:00) April 16, 2011 and
before May 16, 2011.

older_than: newer_than: [Similar to older and newer, but Example: newer_than:2d
allows relative dates using d, m, Meaning: finds messages sent within the
and y for day, month, and year. last two days.
size: Search for messages larger than Example: size:300
the specified size in bytes. Meaning: messages larger than 300 bytes
Abbreviations for numbers (B, K,
M) are allowed. Size limit is Example: size:[300 2000]
2000MB. Meaning: messages larger than 300 bytes
but smaller than 2000 bytes.
larger: smaller: Similar to size, allows abbreviations/Example: larger:1M
for numbers (B, K, M). Size limitis [[Meaning: All messages of at least 1IMB in
2000MB. size.
Example: larger:150K smaller:1M
Meaning: messages larger than 150KB but
smaller than 1MB.
+ Match the search term exactly. Example: +movie
(plus sign) Meaning: minds messages containing
“movie” but not “movies” or “movei”.

Using wildcard characters

A wildcard character is a keyboard character such as an asterisk (*) or a question mark (?) that is used to
represent one or more characters when you are searching for files, folders, printers, computers, or
people. Wildcard characters are often used in place of one or more characters when you do not know
what the real character is or you do not want to type the entire name.

Wildcard character Definition IExampIe

* (asterisk) Used to substitute for zero or more [[Example: subject:d*g
characters. Meaning: finds messages containing
Asterisk ("*") cannot be used in the |words "doing", "dog", "debug", etc.
beginning of the query text.
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? Used to substitute for a single Example: subject:d?g
(question mark) character in a name. Meaning: finds messages containing

words "dog", "dig", "dug", etc.

Search within attachments

Search within attachments is enabled by default. This option can be changed in the Options menu. This
option allows to perform search in attachments’ content.

File | Options | Help

Show notification panel

« | Show progress dialog Select mailboxes or folders to search yeol

€arch within chmen

PST encoding

0y
=-E-E-]

Mailbox Database.edb

Incomplete messages

Show deleted items

* v v ¥

C:\Exchange Server Database\Mailbox Database.edb
Size: 904 Mb

Hg ﬁhm borodeSoe et 1215061 Date: 3/13/2014
ealth Mail 293 Aebb54860a [ ion:
Dﬁ HealthMailboxbaa 80422 260145aa528ba554e( version: Exmange Server 2013

0 dohn Transaction logs not used.

Display time

&9 Luise 22 mailboxes. Select a mailbox to display folders.
[]&9 Maria Woods Load time: 00:00:03

]9 Personal Archive - HealthMailboxade e Fe5b!
]9 Personal Archive - HealthMailboxbaa 8042260
159 Richard

]9 Robert Rise

Dﬁ Romeo Montague

[]£59 Rudy Raid

[[]59 Susane Tyler

-] &9 SystemMailboxfade Sae 7-e5b5-4860-alci-121¢
&[] Tim Goodler

< > File info

Completed

Note

After enabling this option the database will have to be reopened. Search process may take longer when search
within attachments is enabled.

53 Exporting items

Granular Restore for Microsoft Exchange and SQL includes the injection capability for items (emails,
calendars, contacts, etc.) from offline database and PST/OST files to original live Exchange databases as
well as granular data extraction to Personal Storage File (.pst) files.

Page 59



Granular Restore for Microsoft Exchange and SQL 8.0 User Guide

Restore to original live Exchange Server. Standard mode
Important Note

Standard export mode requires access to Active Directory to establish connection to Exchange Server. The
program requests users list from Active Directory and checks if IDs of offline and live user mailboxes
match. That's why the user, logged in, must be a domain user.

After startup, opening an EDB file and checking items the main window of the application looks as
follows:

File  Options Help

. p—
- H Lo Search in Alex Clark

Erowse
=-[8] ) Mailbox Database.ecb | Subject From Ta Created

BE@ fﬂ.hlex Clark . She was glad that Jo should...  Luise Maria Woods; Kyle Pakemman; Luise; ...  Wednesday, March 12, 2014
DH Contacts :,E}“’ ﬂ In itsnature, it is arbitrary and....  Kyle Pakerman Andrew Wait; Richard; John; Dalia; Ro... Wednesday, March 12, 2014
[ Deleted Itéms 25) tt is my lady mother. I is my ... Juliet Capulet Romeo Mortague; Richard; Dalia; Mic... Wednesday, March 12, 2014
Butthat it might not appeart...  John Romeo Montague: Andy Kort: Robert Wednesday, March 12, 2014
Do you persuade yourseff th... Andy Kort Susane Tyler; Andy Kort; Juliet Capulet... Wednesday, March 12, 2014
I regret that | am unable tor...  Brian John; Brian; Tim Goodler; Kyle Pakerm... Wednesday, March 12, 2014
Alas, the heavy basketwhic... Alex Clark Dalia; Kyle Pakeman; Michael; Susan... Wednesday, March 12, 2014
He went up a dark and nam... Rudy Raid Brian; Michael; Richard; Dalia; Luise; T... Wednesday, March 12, 2014
Noone, even there, could liv... Romeo Montague  Brian; Alex Clark; Richard; Romeo Mon... Wednesday, March 12, 2014
One of the things particulary... Robert Rise John; Maria Woods; Richard; Alex Clar... Wednesday, March 12, 2014
Stephen Brice read the new...  Luise AMlex Clark; John; Tim Goodler; Michael... Wednesday, March 12, 2014
Give me some light! Give me... Michael Romeo Mortague; Richard; Andrew W... Wednesday, March 12, 2014
His condition leaves him no ... Juliet Capulet Romeo Mortague; Richard; Juliet Cap... Wednesday, March 12, 2014
What a pied ninny's this! Maria Woods Maria Woods; Brian; Juliet Capulet; Ro... Wednesday, March 12, 2014
Your vows, your memaries, John Fobert Rise; Maria Woods: Andrew W ... Wednesday, March 12, 2014
The riders could be heard Jo...  Andrew Wait Susane Tyler; Maria Woods; Romeo M... Wednesday, March 12, 2014
The sinewand heart of man ... Susane Tyler Brian; Juliet Capulet; Andy Kort; Robert... Wednesday, March 12, 2014

.48 Joumal (27}
(g Junk Email
[ Notes {40}

-[1£9 Andrew Wait

-] ﬁ Andy Kort

-[]&9 Brian

-[]£9 Dalia

-] HealthMaiboxadeJae Ae5b54860a 1cf0218
-[]£9 HealthMaiboxbaa842626014%2a928ba55

[t imnd iy [imm Yo i i Y [ Yiond =

Joh
Eg J:"; Capulet Now, herald, are the dead n...  Alex Clark Michael; Alex Clark; Susane Tyler; Ro...  Wednesday, March 12, 2014

Dﬁ Kyle Pakeman Dieu vous garde, monsieur. ... Michael Maria Woods; Robert Rise Wednesday, March 12, 2014
Dﬁ Luise ff you had seen the lock in h... Romeo Montague  Dalia; Juliet Capulet; Alex Clark; Rome...  Wednesday, March 12, 2014
Dﬁ Maria Woods She wore a gray blouse with... Robert Rise AMlex Clark; Susane Tyler; Maria Woods... Wednesday, March 12, 2014
-[1£3 Michael But though the public schoo... Luise John; Brian; Michael: Andy Kort; Maria .. Wednesday, March 12, 2014
Dﬁ Personal Archive - HeathMailboxade9ae Fe if twas in gold; but atthe sa... Andrew Wait Rudy Raid; Juliet Capulet; Brian; Andy ... Wednesday, March 12, 2014
Dﬁ Personal Archive - HeathMailboxbaaB042e. My stars shine daridy overm... Rudy Raid Juliet Capulet; Tim Goodler; Alex Clark;... Wednesday, March 12, 2014
Dﬁ Richard Charley was of these people... Romeo Mortague  Susane Tyler; Alex Clark; Michael; Rud... Wednesday, March 12, 2014
D,@ Robert Rise Richard Richard: John: Andy Kort: Robert Rise: . Wednesday, March 12, 2014 %
£ >
Completed Selected: & item(s) in 1 mailbox(es)

Clicking the injection button will bring up the following dialog box:
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Host (ex.: contoso.com or 192.168.0.5):

| ES2013 no-such-email.com

|| Refresh || Advanced.. |

Details:

[[] Unselect successfully exported items

Export from source mailbox “Alex Clark’ to destination mailbox Alex Clark @no-such-email.com: 19 items |

| Diagnostics |

About export into original mailbox

Selected items will be copied from
offline mailboxes into their original
locations on live Exchange Server.

The destination Exchange Server is
detected automatically using the
current Active Directory domain.
Current user should be a member
of the same domain as target
Exchange Server and should have
Exchange impersonation access to
destination mailboxes.

Each selected item will go to its
original location in respective
mailbox, e.g. Patrick’s offline mail
will go to Patrick’s mailbox, Lisa's
calendar items to Lisa's mailbox
etc. When selected items cannot be
matched to destination mailbox,
they will not be exported.

Domain name of the machine with Exchange Server will be automatically detected if current machine is
in the same domain with Exchange Server. Otherwise, the host will not be detected and has to be
entered manually. By default, Granular Restore for Microsoft Exchange and SQL uses current user to
establish the connection. If current user doesn't have rights to impersonate selected for export user, an

appropriate error will appear in details.

In case of error it is recommended to use the Advanced button and configure the connection settings.
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Host (e : contoso com or 152 1680 5):
ES2013.no-such-email.com

- Exchange impersonation lets you connect to
b
Use cument Windows credentials smail her than the default for
credentizls. To use the festure, access
Uzer logon name (ex.: userT): permissions need to be configured at

Exchange Server.

[[] Save password

There are two ways to connect to selected mailbox:

1. Use credentials of selected mailbox.
2. Specify the user that has impersonation rights.

To use credential of selected mailbox, enter host name of machine with Client Access Role, unmark Use
current Windows credentials enter user name and password and press Connect.

Host (ex.: cortoso.com ar 192.168.0.5):
|E52'|]1 3 no-such-email.com

- Exchange impersonation lets you connect to
(] Use cument Windows credentials a mailbox other than the default one for your
credentials. To use the feature, access
Lser logon name (ex.: userl): permissions need to be configured at

|.Nex.[]ar|c Exchange Server.

Password:

[] Save password
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To use Exchange impersonation to establish the connection, enter host name of machine with Client
Access role, unmark Use current Windows credentials, enter credentials of the user with impersonation
rights and press Connect. In the example below Brian has impersonation rights to access Dalia's mailbox.

Host {ex.: contoso.com or 192.168.0.5):
|E52'|]13.nu-sud1-emai|.cum

U ment Wind crederticl Ex{:hgrrue impersonation lets you connect to

[ Use cu neews 1= a mailbox other than the default one for your
credentials. To use the feature, access

Lzer logon name {ex.: user1): permissions need to be configured at

| Eran Exchange Server.

Passwaord:

|

[] Save password

Exporting to live Exchange is also available via the File menu.
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Q
File | Options

Help

Open file...

Recent

Close file

Reload database using transaction logs

Search for files to open...

Export selected itemns into PST...

port into oniginal Exchange mailbox...

Ctrl+O

Ctrl+S

tri+

Cancel current operation

Open log folder

Delete saved temp files and logs

Exit

Ctrl+N

- Toy
w13 Tasks (49)
-[159 Andrew Wait
-] @ Andy Kort
-[]&9 Brian
-] Dalia

-] John

-1 Juliet Capulet
-9 Kyle Pakeman
-1 Luise

-9 Maria Woods
1759 Michael

-[]&9 Richard
-[1£9 Robert Rise

£
Completed

-[]£9 HealthMaiboxadeSae Ae5b54860a1cf0218
-] @ HealthMaiboxbaa 8042 260143aa328ba5b5

-[_]£9 Personal Archive - HealthMailboxads $as e
D@ Personal Archive - HeathMailboxbaa 8042

[<][e][3

[«

HEREEEEE

~ ][]

DNNNENENNEENENENNENED e mm

[t o) ion [t o) i Y o} [T} =

Subject

She was glad that Jo should....
In itsnature, it is arbitrany and...
tt is my lady mother. I is my ...
Butthat it might not appeart...
Do you persuade yourself th...
| regret that | am unable tor...
Mas, the heavy basketwhic...
He went up a dark and nar...

Noone, even there, could liv

One of the things particulary...
Stephen Brice read the new...
Give me some light! Give me...
His condition leaves him no ...

What a pied ninny's this!

*four vows, your memories, ...

The riders could be heard Jo....
The sinewand heart of man ...
Now, herald, are the dead n...
Dieu vous garde, monsiedur. ...
I you had seen the look inh...
She wore a gray blouse with...
But though the public schoo...
if itwas in gold; but at the sa...
My stars shine darkly overm...
Charley was of these people....

Search in Alex Clark

From

Luise

Kyle Pakerman
Juliet Capulet
John

Andy Kort

Brian

Alex Clark

Rudy Raid
Romeo Montague
Robert Rise

Luise

Michael
Juliet Capulet
Maria Woods
John
Andrew Wait
Susane Tyler
Alex Clark
Michael

Romeo Mortague
Robert Rise

Luise
Andrew Wait
Rudy Raid
Romeo Mortague
Richard

To

Maria Woods; Kyle Pakeman; Luise; ..

Andrew Wait; Richard; John; Dalia; Ro...
Romeo Mortague; Richard; Dalia; Mic...
Romeo Mortague; Andy Kort; Robert ...
Susane Tyler; Andy Kort; Juliet Capulet...
John; Brian; Tim Goodler; Kyle Pakem...
Dalia; Kyle Pakeman; Michael; Susan...

Brian; Michael; Richard; Dalia; Luise; T...

Brian; Alex Clark; Richard; Romeo Mon
John; Maria Woods; Richard: Alex Clar...
AMlex Clark; John; Tim Goodler; Michael...
Romeo Montague; Richard; Andrew W...
Romeo Montague; Richard; Juliet Cap...
Maria Woods; Brian; Juliet Capulet; Ro...
Robert Rise; Maria Woods; Andrew W...
Susane Tyler; Maria Woods; Romeo M...
Brian; Juliet Capulet; Andy Kort; Robert...
Michael; Alex Clark; Susane Tyler; Ro...
Maria Woods; Robert Rise

Dalia; Juliet Capulet; Alex Clark; Rome...
Alex Clark; Susane Tyler; Maria Woods...
John; Brian; Michael; Andy Kort; Maria ...
Rudy Raid: Juliet Capulet; Brian; Andy ...
Juliet Capulet: Tim Goodler; Alex Clark...
Susane Tyler; Alex Clark; Michael; Rud...
Richard; John; Andy Kort; Robert Rise;...

Created

Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday.
Wednesday,
Wednesday,

Selected: 1 folder(s} in 1 mailbox{es)

March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12. 2014
March 12, 2014
March 12, 2014

>

After establishing the connection, the export will start. Required time depends on how many items are

selected for export. You will be shown a progress window during the export. The window shows the

number of saved folders, messages, errors and total expected items to be restored. You can disable the

progress window directly in the window or go to the Options menu and select Show progress dialog.

The export can be cancelled by clicking the Cancel exporting button on the taskbar.
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File  Options Help

p—
N i
S hin Alex Clark
H % earch in Alex Lial
e

Browse

=-[m] v Mailbox Database edb Type  f] Subject From To Created

B."’zléextg:dar 438) =] She was glad that Jo should... Luise Maria Woods; Kyle Pakeman; Luise; ...  Wednesday, March 12, 2014
4. Contacts |345} 4 f] Initsnature, it is arbitrary and... Kyle Pakeman Andrew Wait; Richard; John; Dalia; Ro... Wednesday, March 12, 2014
£33 Deleted tems (25) e o trem =" ie; Richard; Dalia; Mic... Wednesday, March 12, 2014
CaDmfts D) Progress 1e; Andy Kort; Robert .. Wednesday, March 12, 2014
(] Inbox |:,Dd5: dy Kort; Juliet Capulet... Wednesday, March 12, 2014

A Joumal 27) ErTibrm e Er s S e Goodler; Kyle Pakem... Wednesday, March 12, 2014

C3 Junk Email (0) mman; Michael; Susan... Wednesday, March 12, 2014
. MNotes (40) lichard; Dalia; Luise; T... Wednesday, March 12, 2014
£ Outbox (0) elders : Richard: Romeo Mon... Wednesday. March 12, 2014

W]C3 Sent tems (0) Messages ads; Richard; Alex Clar... Wednesday, March 12, 2014

[ & Tasks (48) Errors ; Tim Goodler; Michael... Wednesday, March 12, 2014
-[159 Andrew Wait Total messages count 1e; Richard; Andrew W... Wednesday, March 12, 2014
Dﬁ Andy Kort Elapsed time LS 1e; Richard; Juliet Cap... Wednesday, March 12, 2014

-[]&9 Brian dan; Juliet Capulst;

. : pulet; Ro... Wednesday, March 12, 2014
05 Cancel cument operat )
Dala - ey ria Woods: Andrew W... Wednesday, March 12, 2014

Eg Eea:::af::deg';;ei;ﬁ“a;gz; Show the dialog next ime aria Woods: Romeo M. Wednesday, March 12, 2014
nl=] et e Jet: Andy Kort: Robert . Wednesday, March 12, 2014

Dﬁ Juliet Capilet Now, herald, are the dead n...  Alex Clark Michael; Alex Clark; Susane Tyler; Ro...  Wednesday, March 12, 2014
-] ¥yt Pakeman Dieu vous garde, monsieur. ... Michael Maria Woods; Robert Rise Wednesday, March 12, 2014
Dﬁ Luise ff you had seen the look in h... Romeo Mortague  Dalia; Juliet Capulet; Alex Clark; Rome...  Wednesday, March 12, 2014
-] &9 Maria Woods She wore a gray blouse with... Robert Rise Alex Clark; Susane Tyler; Maria Woods... Wednesday, March 12, 2014
Dﬁ Michael But though the public schoo... Luise John; Brian; Michael; Andy Kort; Maria ... Wednesday, March 12, 2014
Dﬁ Personal Archive - HeathMailboxade9ae Fe if itwas in gold; but at the sa... Andrew Wait Rudy Raid; Juliet Capulet; Brian; Andy ... Wednesday, March 12, 2014
Dﬁ Personal Archive - HealthMailboxbaz 8042 My stars shine darkly overm... Rudy Raid Juliet Capulet; Tim Goodler; Alex Clark:... Wednesday. March 12, 2014
Dﬁ Richard ﬂ Charley was of these people... Romeo Mortague  Susane Tyler; Alex Clark; Michael; Rud... Wednesday, March 12, 2014

D,@ Robert Rise Richard Richard; John; Andy Kort; Robert Rise;.. Wednesday, March 12, 2014 %
£ > >

R EREEE

DNNENEENEEE

~ @

Exporting into original Exchange Server mailbox (folders: 0., 00:00:06 Selected: 1 mailbox(es)
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Working with clustered Exchange Server configuration

Exporting data into live instance of clustered Exchange Server does not differ from working with any

other server configuration. Even if there are several servers with Mailbox Server roles in your
configuration, and they have been added to your CCR/DAG, data can be easily restored.

Client Access Active Directory

Server Domain Controller
B
|
| ¥
|
CCR/DAG

el Client PC with
| Restore Tool
| -
I Maillbox
L _Serverl _ __ Sel - el

.-"'-

Offline Database
Storage

As you can see on the scheme, to export data into live server, Granular Restore for Microsoft Exchange
and SQL calls Client Access Server to get access to specified mailbox. And it doesn't really matter which
of existing Mailbox Servers stores target mailbox - data will be exported to the right place.

The IP-address or FQDN of Client Access Server should be specified in the Host field while using the
Expert mode. In the Export into original mode FQDN of this server is detected automatically by calling
Active Directory domain controller.
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Restore to PST files

To save items marked for export, click the Export selected items button on the toolbar or select the

point in the File menu.

File  Options

Il

Help

A =

Browse
=-[m] v Mailbox Database edb

B-[m] 5 Alex Clark

-[] Calendar (438)

[[]22] Contacts (45)
] Deleted tems (25)
[(]Ea Drefts (0)
Mta
Dj Joumal (27}
[(1E3 Junk Email (0)
[Ji. Notes (40)
[ Outbox (0)
[CJEa Sent tems (0)
121 Tasks (48)
-[1&9 Andrew Wait
155 Andy Kort
-[]&9 Brian
-] Dalia

-] John

-1 Juliet Capulet
-9 Kyle Pakeman
-1 Luise

-9 Maria Woods
1759 Michael

-[]&9 Richard
-[1£9 Robert Rise

£
Completed

-[]£9 HealthMaiboxadeSae Ae5b54860a1cf0218
-] ﬁ HealthMaiboxbaa 8042 260143aa328ba5b5

-[_]£9 Personal Archive - HealthMailboxads $as e
Dﬁ Personal Archive - HeathMailboxbaa 8042

| Type

EEE

o

HEEEEE

EEE

R EEEE

~ @

DENNENENNEENENN DO MEEERNDHEE

0
0

[t o) ion [t o) i Y o} [T} =

Subject

She was glad that Jo should....
In itsnature, it is arbitrany and...
tt is my lady mother. I is my ...
Butthat it might not appeart...
Do you persuade yourself th...
| regret that | am unable tor...
Mas, the heavy basketwhic...
He went up a dark and nar...

Noone, even there, could liv

One of the things particulary...
Stephen Brice read the new...
Give me some light! Give me...
His condition leaves him no ...

What a pied ninny's this!

*four vows, your memories, ...

The riders could be heard Jo....
The sinewand heart of man ...
Now, herald, are the dead n...
Dieu vous garde, monsiedur. ...
I you had seen the look inh...
She wore a gray blouse with...
But though the public schoo...
if itwas in gold; but at the sa...

My stars shine darkly overm...
Charley was of these people....

Search in Alex Clark

From

Luise

Kyle Pakerman
Juliet Capulet
John

Andy Kort

Brian

Alex Clark

Rudy Raid
Romeo Montague
Robert Rise

Luise

Michael
Juliet Capulet
Maria Woods
John
Andrew Wait
Susane Tyler
Alex Clark
Michael

Romeo Mortague
Robert Rise

Luise
Andrew Wait
Rudy Raid
Romeo Mortague
Richard

To

Maria Woods; Kyle Pakeman; Luise; ..

Andrew Wait; Richard; John; Dalia; Ro...
Romeo Mortague; Richard; Dalia; Mic...
Romeo Mortague; Andy Kort; Robert ...
Susane Tyler; Andy Kort; Juliet Capulet...
John; Brian; Tim Goodler; Kyle Pakem...
Dalia; Kyle Pakeman; Michael; Susan...

Brian; Michael; Richard; Dalia; Luise; T...

Brian; Alex Clark; Richard; Romeo Mon
John; Maria Woods; Richard; Alex Clar...
AMlex Clark; John; Tim Goodler; Michael...

Romeo Montague; Richard; Andrew W...

Romeo Montague; Richard; Juliet Cap...
Maria Woods; Brian; Juliet Capulet; Ro...
Robert Rise; Maria Woods; Andrew W...
Susane Tyler; Maria Woods; Romeo M...
Brian; Juliet Capulet; Andy Kort; Robert...
Michael; Alex Clark; Susane Tyler; Ro...

Maria Woods; Robert Rise

Dalia; Juliet Capulet; Alex Clark; Rome...

Alex Clark; Susane Tyler; Maria Woods...
John; Brian; Michael; Andy Kort; Maria ...
Rudy Raid: Juliet Capulet; Brian; Andy ...
Juliet Capulet: Tim Goodler; Alex Clark...
Susane Tyler; Alex Clark; Michael; Rud...
Richard; John; Andy Kort; Robert Rise;...

Created

Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday,
Wednesday.
Wednesday,
Wednesday,

Selected: 1 folder(s} in 1 mailbox{es)

You will be asked to select or create the destination folder for recovered data:

March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12, 2014
March 12. 2014
March 12, 2014
March 12, 2014 ¥
>
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Selected data will be saved into pst file(s). To start the export select the destination
folder or create a new one and click OK. The export process will start immediately.

Program Files 2

W

Program Files (x86)

Recovered_session
Recovered_sessiond
Recovered_session3
Recovered_sessiond

Recovered_session3

—— — — R e e

Recovered_sessiond |

[ totalerndd

P5T encoding: | Unicode (Microsoft Outlook 2003, 2007, 2010 and 2013)

Make Mew Folder | Ok || Cancel

After selecting folder, the export will start. Required time depends on how many items are selected for
export. You will be shown a progress window during the export. The window shows the number of
saved mailboxes, folders, messages and total expected items to be restored (1). You can disable the
progress window directly in the window or go to the Options menu and select Show progress dialog.

The export can be cancelled by clicking an appropriate link in the progress dialog window (2) or by
clicking the Cancel export button on the taskbar (3).
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File Options Help

| Search in all mailboxes

Sp— ) v

Browse

Bk
E

Mailbox Database.edb

PR S G S Y A S|

Progress

Exporting into PST... 7%

5 Personal Archive - HealthMailboxade9ae 7¢ >
(= Personal Archive - HealthMailboxbaa8042e Elapsed time
= Richard

Robert Rise
Romeo Montague -

-[¥] 59 SystemMailbox{adeSae -e5b5-4860-a1cf{ Show the dialog next time
-[¥] =9 Tim Goodler

< 2
Exporting into PST... 7% . Selected: 22 mailbox(es)

Tip

If you closed the progres window, it can be shown again by clicking on the progress bar on the status.

PST file naming, size and format

Granular Restore for Microsoft Exchange and SQL exports each mail store into a separate .pst file named
“Recovery NNN - <Mailbox Name>[ - VVV] . pst”, where NNN is current recovery session identifier, VVV
—volume number in case the PST has to be written in more than one volume.

Example:

Recovery 001 - John Doe.pst Recovery 001 - John Doe - 001.pst Recovery 001 - John Doe - 002.pst
Recovery 001 - Mary Smith.pst

With large exports, there can be more than one file on the output. Additional files are created
automatically when the file size limit is hit. The size volume limit depends on the output file encoding.
For ANSI PST files the limit is 1GB, for Unicode files it is 10GB.
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Opening exported items in Outlook

To view and manipulate exported items, use Microsoft Outlook to open the Personal Storage File (.pst)
files exported by Granular Restore for Microsoft Exchange and SQL:

1. Start Outlook.
2. Click File and choose Open Outlook Data File.
3. Select exported pst file and click OK.

L] 5 Outlook Today - Microsoft Outlook

File: Home Send / Receive Folder View

£ Open Calendar

puammmy  Open a calendar file in Outlook (.ics, ves

O
Info t
Open {3  Open Outlook Data File
Open an Outlook data file (.pst).
Print
Help — /O] Open Outlook Data File
] Options &' @Uv’ 5| » Libraries » Documents » v ] 5 ’ ‘ Search Documents ol
Exit Organize v New folder = v A @
< Recent Pl & E
i ecent Haces Documents library 7 o
Arrange by:  Folder ¥
= Includes: 2 locations
4 Libraries .
=) Documents Name Date modified A
@' Music 9] Recovery 001 - Juliet Capulet 8 22:2 ¢
| Pictures E 2] Recovery 002 - Andrew Wait C
B videos 9] Recovery 002 - Susane Tyler C
3] Recovery 002 - Kyle Pakerman
1% Computer 3] Recovery 002 - Andy Kort
:’; Local Disk (C:) i_J Recovery 002 - SystemMailbox{78d3a78c-3€71-42c9-a8...
- Local Disk (D:) 3] Recovery 002 - Rudy Raid
G VRPNV, S, S P PP S pry r
ca Local Disk () + ¢ s B T »
File name: Recovery 001 - Juliet Capulet v [Outlook Data File V]
Tools ~ | oK I ‘ Cancel ]
Note

It is not recommended to move .pst files that are open in Outlook. Before moving, right- click the name of

the Outlook Data File (.pst) and click Close .

Restoring exported items into Exchange Server

Items extracted from a mail store can be easily restored into a live server:

1. Make sure you have Microsoft Outlook with access to the mailbox you want to restore items into.

2. Open .pst file with exported messages.

3. Open the mailbox you need to import data into.
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4. Select the items and drag-and-drop them back into the original folders. They will be automatically
synchronized with the live Exchange Server database.

w Send / Receive Folder View

L= v = = / A3 ¥ o~ ‘ ~
@ %= Clean Up x = 7\’ [_.i B, Meeting l& Restored Mail [, To Manager IB J
& Junk - - " &4 Team E-mail « Done -
New  New Delete | Reply Reply Forward &% pore - | -~ o - — | Move O
Evagil Hemer Al -5 {5 Reply & Delete " Create New 5d l
New Delete Respond Quick Steps a Mov
Drag Your Favorite Folders Here <
_________________________________________________________________________________ |Search Inbox (Ctrl~E) Pl
4 Exchange Mailbox Arrange By: Date Newestontop 7

m

[} Sent Items o | 4 lastWeek
(5 Deleted Items {4 Andy Kort Thu8/ie
3 Drafts subj About the Test Mailbox Store ¢
-1 Romeo Montague Thu 8/16

L@ Junk E-mail e s OX
@ @ The farmer imagines power and
£ Restored Mail ] John Thu8/16
B ﬁ;s :’ed ! Whilst the world is thus g =

o 1 Robert Rise Thus/ts
g Sesreh Foiders POLARITY or action and reaction we meet in o

Shortcuts

N Kyle Pakerman Thu 8/16

4 Recovery 001 - Juliet Capulet there is one man of genius who has done much for this phil... 4

(&) Deleted Items

[_d Conversation Action Settings
[ Drafts

Junk E-Mail
m Search Folders

-] John Thu 8/16

[ Orphaned Folders Emerson spent the latter part of his life in lecturing and g
[ Outbox {4 Alex Clark Thu 8/16
F LIMITED RIGHT OF REPLACEMENT 4
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6 Command-line interface

The command line feature allows you to easily process several databases. Usage: esr.exe <source>
<destination>

Example: esr.exe "c:\Mailbox Database.edb" "c:\results\"

Below is a list of commands with their description that can be used in command line: There are s everal

ways to set the source file(s):

|Operation Description |Examp|e
<file maskpath> mask to path with files esr.exe c:\*.edbc :\results\
list=<path> sets a pathto file which esr.exe
contains a list with files to list=d:\files_to_recover.txt
list={filel,file2,...,fileN} sets enumeration of files to esr.exe /list={d:\1.edb,
|recover. Full path to file must be |d:\2.edb}c:

Specify the destination directory for the recovered file(s):

IOperation IDescription IExampIe

I<out dir> Ipath to output directory Iesr.exe c:\*.edb c :\results\

Detailing parameters:

IOperation IDescription IExampIe
/initdir=<path> Isets the initial directory for the esr.exe /initdir="c:\EDB Mailboxes
Open database dialog "

shows messages that have been
-notfilterfaultymessages filtered due to their damage esr.exe -notfilterfaultymessages

esr.exe c:\*.edb c :\results\ /

/redirect=<path> redirects console output to text redirect="c:\result.txt"
file
if set - the product will remove all
/cleartemp temp data on startup esr.exe /cleartemp
6.1 Extended command-line interface

Extended command-line interface can help to automate various command-line operation.

Automation commands begin with /auto switch. To address individual items, such as mailboxes, folders
and messages, their IDs are used. To obtain an object’s ID, the 'lh' automation command is used.
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Oper
ation

/auto

fd

ea

Description

Begins automation sequence. Parameters that
follow will specify automation.

Lists EDB objects (tab-separated: Id, Name,
Parent Id). Also see /items and /r options.

Note: mailbox(es) or folder(s) IDs must be used
in /items parameter.

Lists messages (tab-separated: Id, Subject). Also
see /items and /r options.

Note: folder(s) ids must be used in /items
parameter

Shows folder details (tab-separated: Id, Name,
MessageCount, Class). Also see

/items option.

Note: folder(s) ids must be used in /items
parameter

Extracts items. Also see /items and /rcs options.
See /pstencoding to set PST encoding.
See /outdir to set output folder.

Note: mailbox(es), folder(s) or email(s) IDs must
be used in /items parameter.

Extracts attachments from message. Also see
/items option.
See /outdir to set output folder.

Note: folder(s) or email(s) ids must be used in /
items parameter

Example

esr.exe "c:\EDB Mailboxes\privl.edb" /auto |h /
items={FF55DD44-EE6788DD,
BB3345F4-EE788922}

esr.exe "c:\EDB Mailboxes\privl.edb" /auto |h
/items={FF55DD44-EE6788DD, BB3345F4-
EE788922}

esr.exe "c:\EDB Mailboxes\privl.edb" /auto Im /
items={FF55DD44-EE6788DD, BB3345F4-
EE788922}

esr.exe "c:\EDB Mailboxes\privl.edb" /auto fd
/items={FF55DD44-EE6788DD}

esr.exe "c:\EDB Mailboxes\privl.edb" /auto e /
items={FF55DD44-EE6788DD} /outdir="C:
\results\”

esr.exe "c:\EDB Mailboxes\privl.edb" /auto ea
/items={FF55DD44-EE6788DD} /outdir="C:
\results\”
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Oper
ation

pm

Description Example

Does performance test (tab-separated output: |esr.exe "c:\EDB Mailboxes\privl.edb" /auto pm

Operation Elapsed time hh:mm:ss, Count). / items={FF55DD44-EE6788DD} /
Sequence: itemscount=3000 /outdir="C:\results\”
1. Opens EDB

2. Saves items.
Use /itemscount to pass a number of items to
save
Use /items to pass a folder with items to save or
an item list(or one item) to save.
See /pstencoding to set PST encoding. See
/outdir to set output folder.

Note: if you pass an email id in /items parameter
it will be saved “/itemscount” times.

Searches for provided query string (see esr.exe "c:\EDB Mailboxes\privl.edb" /auto s /
/query option). query={has_words=email}

Output: same as in Im command.

Use /items option to set a folder where to

search. Otherwise, search will be performed on a

whole database.

Below there is list of options and their descriptions that can be used with command-line operations,

described above.

Operation Description Example

/ List of items(mailbox, folder, message, esr.exe "c:\EDB Mailboxes\privl.edb" /auto

items={id1,id2,. |calendar IDs etc.) in hexadecimal format Root/lh /items={FF55DD44-EE6788DD,

) ID = 1 (/items={1}) BB3345F4-EE788922}

s Recursively includes subfolders into current |esr.exe "c:\EDB Mailboxes\privl.edb" /auto
operation. Im /items={FF55DD44-EE6788DD,

BB3345F4-EE788922} /r
/ itemscount=<c Count of items to save. esr.exe "c:\EDB Mailboxes\privl.edb" /auto
ount> ps /items={FF55DD44-EE6788DD} /

itemscount=5
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query=<query>

Search query string.
“:]” sequence is used to divide search
parameters in string.
Parameters (see search tab of the Ul):
1. has_words — “Has words” field
2. no_words — “Doesn’t have” field
3. has_attach — “Has attachments” field.
True or false.
. from — “From” field
. to — “To” field
. subject — “Subject” field
. datefrom — start date of range in
“dd/MM/ yyyy” format
8. dateto — end date of range in “dd/MM/
yyyy” format

N o A

esr.exe "c:\EDB Mailboxes\privl.edb" /auto
s /query={has_words=email; |
no_words=theme;| has_attach=true;|
from=Brian;|to=Romeo; | subject=Test this
App; | datefrom=10/04/2013;|
dateto=10/05/2013}

pstencoding=<
encoding>

Encoding of PST file. Values:
Unicode(default), ANSI.

esr.exe "c:\EDB Mailboxes\privl.edb" /auto
ps /items={FF55DD44-EE6788DD} /
itemscount=3000 /pstencoding=ANSI /
outdir="C:\results\”

outdir=<path>

Path to output folder

esr.exe "c:\EDB Mailboxes\privl.edb" /auto
ps /items={FF55DD44-EE6788DD} /
itemscount=3000 /outdir="C:\results\”

Application Exit Codes

Co Description
de
0 [|OK

1 [Some errorsin parameters

2 No data to restore

3  |Empty /item or / outdir parameter, operation did not start
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7 Glossary

This glossary lists terms and their synonyms, most commonly used in Granular Restore for Microsoft
Exchange and SQL help.

AD - Active Directory (AD) is a directory service implemented by Microsoft for Windows domain
networks. An AD domain controller authenticates and authorizes all users and computers in a Windows
domain type network. For additional information, please visit
http://en.wikipedia.org/wiki/Active_Directory.

ANSI PST format - An old PST-file format, used in Outlook 97-2002. ANSI format has a 2 GB limit in file
size.

Deleted items - Items/folders deleted from a mailbox hierarchy.
Destination folder/mailbox - A folder/mailbox, selected for export.

EDB - An Exchange database format, used to store information from users’ mailboxes. Synonyms:
Exchange Server database, dataset.

EWS - Exchange Web Services. EWS provides the functionality to enable client applications to
communicate with the Exchange server. EWS provides access to much of the same data that is made
available through Microsoft Office Outlook.

Exchange impersonation - Exchange impersonation enables a caller to impersonate a given account so
that the operations can be performed with the rights of the impersonated account, instead of the rights
that are associated with the caller's account. Configuration information is available at
http://msdn.microsoft.com/en-us/ library/office/bb204095(v=exchg.140).aspx

Exchange Server - A mail server, calendaring software and contact manager developed by Microsoft.
Export - Copying information from an offline mailbox so it can be stored in a pst file or on the live
Exchange Server.

GMT - Greenwich Mean Time (GMT) is considered as a reference point for time.
Host - Domain name of the machine with Client Access role of Exchange Server, or IP address.

Injection - The process of copying data from offline mailbox to live or original connected mailbox on the
server. Local time - Local time is calculated by adding or subtracting a number of hours, depending on a
time zone, to UTC.

Live Exchange Server mailbox - Destination Exchange server mailbox, that exists on the server and is
available for connection. Synonym: attached mailbox.
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Mail Store - A type of self-storage whereby customers send items by mail or delivery service (usually by
the box) to be stored at a central location. Synonyms: mailbox, offline database, Outlook storage,
database storage(depending on the conext).

Original mailbox - A mailbox in live Exchange Server that corresponds to the mailbox in the opened
database.

OST - An Offline Storage Table (.ost) format. OST is used by Microsoft Exchange Server that enables
users to work with their messages and mail data even when access to the mail server isn't available.

PST - A Personal Storage File (.pst) format, used to store copies of messages, calendar events, and other
items. PST files are readable with Outlook or other compatible email client.

Unicode PST format - A PST-file format used in Outlook 2003, Outlook 2007, Outlook 2010 and Outlook
2013, so older versions of Outlook will not be able to open Unicode formatted PST files. Previous
versions of Outlook were using ANSI format. The main reason for this change was to allow for
international character support and to extend the maximum size of PST files beyond the 2GB limit of the
ANSI formatted PST files. UTC - Coordinated Universal Time (UTC) is the primary time standard by which
the world regulates clocks and time. Usually used with references to time zones.
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